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Important User Information
Solid-state equipment has operational characteristics differing from those of electromechanical equipment. Safety 
Guidelines for the Application, Installation and Maintenance of Solid State Controls (publication SGI-1.1 available from 
your local Rockwell Automation sales office or online at http://www.rockwellautomation.com/literature/) describes some 
important differences between solid-state equipment and hard-wired electromechanical devices. Because of this difference, 
and also because of the wide variety of uses for solid-state equipment, all persons responsible for applying this equipment 
must satisfy themselves that each intended application of this equipment is acceptable.

In no event will Rockwell Automation, Inc. be responsible or liable for indirect or consequential damages resulting from 
the use or application of this equipment.

The examples and diagrams in this manual are included solely for illustrative purposes. Because of the many variables and 
requirements associated with any particular installation, Rockwell Automation, Inc. cannot assume responsibility or 
liability for actual use based on the examples and diagrams.

No patent liability is assumed by Rockwell Automation, Inc. with respect to use of information, circuits, equipment, or 
software described in this manual.

Reproduction of the contents of this manual, in whole or in part, without written permission of Rockwell Automation, 
Inc., is prohibited.

Throughout this manual, when necessary, we use notes to make you aware of safety considerations.

Allen-Bradley, Rockwell Software, Rockwell Automation, RSLogix 5000, ControlLogix, ProcessLogix, RSLinx, ControlFlash, PLC-5, PLC-3, SLC, and TechConnect are trademarks of Rockwell Automation, Inc.

Trademarks not belonging to Rockwell Automation are property of their respective companies.

WARNING: Identifies information about practices or circumstances that can cause an explosion in a hazardous 
environment, which may lead to personal injury or death, property damage, or economic loss.

ATTENTION: Identifies information about practices or circumstances that can lead to personal injury or death, 
property damage, or economic loss. Attentions help you identify a hazard, avoid a hazard, and recognize the 
consequence

SHOCK HAZARD: Labels may be on or inside the equipment, for example, a drive or motor, to alert people that 
dangerous voltage may be present.

BURN HAZARD: Labels may be on or inside the equipment, for example, a drive or motor, to alert people that 
surfaces may reach dangerous temperatures.

IMPORTANT Identifies information that is critical for successful application and understanding of the product.

http://literature.rockwellautomation.com/idc/groups/literature/documents/in/sgi-in001_-en-p.pdf
http://www.rockwellautomation.com/literature/


Summary of Changes

This manual contains new and updated information. This manual includes the 
addition of the 1756-RIO/B module. Changes throughout this revision are 
marked by change bars, as shown to the right of this paragraph.

New and Updated 
Information

This table contains the changes made to this revision.

Topic Page

1756-RIO module front diagram 13
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Preface

Introduction This manual describes how to configure and troubleshoot your Logix Remote 
I/O (RIO) Communication Module. 

The 1756-RIO module:

• runs in a ControlLogix environment.

• allows upgrade from PLC-5, PLC-3, or SLC systems to a ControlLogix 
system with a minimum of downtime and startup time.

• uses integer data.

• does not require MSG instructions. All data is scheduled.

• offloads block transfer execution to reduce processing burden on the 
processor.

This publication explains how and why you would use a 1756-RIO module. 
The module is used in two modes, scanner and adapter mode.

In scanner mode, the 1756-RIO module enables communication and data 
transfer between a ControlLogix controller and devices on a Remote I/O 
network. The module continuously scans adapters on the remote network. The 
module transfers discrete and block transfer data.

In adapter mode, the module performs two functions simultaneously. First, it 
emulates one or more racks of I/O to a scanner, exchanging data with that 
scanner. Second, it monitors other remote I/O racks on the same Remote I/O 
network.

It can be used to upgrade an existing PLC-5, PLC-3, or SLC system to a 
ControlLogix system. 

The advantages of using the 1756-RIO module to upgrade your system 
include:

• allowing the user to leave the existing Remote I/O network in place, 
alleviating the time and/or expense of replacing the I/O and field 
wiring, or the process of testing out field wiring.

• allowing the new application to be tested before you switch over, so that 
it works just like the old one.

• allowing you to switch back to the old application in minutes, should 
you run into problems.

For installation information, see the Remote I/O (RIO) Module Installation 
Instructions, publication 1756-IN610.
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Preface
Who Should Use This 
Manual

We assume you understand remote I/O (RIO) modules and the host 
controller system (ControlLogix). 

This manual is intended for individuals who use DHRIO, PLC-5, PLC-3, SLC, 
or ControlLogix systems, such as:

• software engineers.

• control engineers.

• application engineers.

• instrumentation technicians.

Information Found in This 
Manual

This manual is broken into five parts:

• General module information and features - Chapter 1 and Appendix D

• Scanner mode functionality - Chapter 2, and Appendices A and C

• Adapter mode functionality - Chapter 3, and Appendices B and C

• Linking module configuration with an RSLogix 5000 project - Chapter 4 
Monitoring remote I/O - Chapter 5

Additional Resources These documents contain additional information concerning related Rockwell 
Automation products.

You can view or download publications at
 http://literature.rockwellautomation.com. To order paper copies of technical 
documentation, contact your local Rockwell Automation distributor or sales 
representative.

Resource Description

Remote I/O (RIO) Module Installation 
Instructions, 
publication 1756-IN610

Provides details on how to install the 1756-
RIO module

Industrial Automation Wiring and Grounding 
Guidelines, publication 1770-4.1

Provides general guidelines for installing a 
Rockwell Automation industrial system

Product Certifications website,
 http://ab.com

Provides declarations of conformity, 
certificates, and other certification details
10 Publication 1756-UM534B-EN-P - November 2010
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Chapter 1

The 1756-RIO Module-Getting Started

Introduction This document is a user’s guide for the 1756-RIO module. The module lets 
Rockwell Automation ControlLogix controllers communicate with remote I/
O over the backplane or over a remote network. This chapter describes the 
ControlLogix 1756-RIO module and how it links a ControlLogix controller to 
the Universal Remote I/O network. 

This chapter also describes the module’s physical features, software 
requirements, software and add-on profile installation instructions, and 
RSLogix 5000 project setup.

The 1756-RIO module:

 supports native RIO 16-bit words for data, control, and status bits. 

 acts as a scanner on a Remote I/O network.

 acts as an adapter that exchanges data on a Remote I/O network. 

 supports discrete data and block transfer data in either mode.

 supports up to 10 produced/consumed data connections (along the 
backplane between the ControlLogix controller and the 1756-RIO 
module) with 248 words of integer input and 248 words of integer 
output for each connection. 

 uses produced/consumed connections using a 1756-RIO add-on profile 
in RSLogix 5000 programming software. 

 supports requested packet intervals (RPIs) from 2…750 ms. All 
connections use one set RPI.

 maps all discrete and block transfer data into produced/consumed 
connections. 

 monitors existing I/O in adapter mode (Monitor mode). It can report 
all existing inputs and outputs, discrete and block transfer module data 
to the ControlLogix controller.

Topic Page

1756-RIO Module Components 13

1756-RIO Module Requirements 15

Prepare the Module 16

Install the Software 19

Install the Add-on Profile 19

Create the RSLogix 5000 Project 22

Launch the Configuration Tool and Select the Module Mode 30
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The following modules are supported by the 1756-RIO module.

Supported Modules

See Appendix C for additional information.

I/O Family Cat. No.

1746 SLC  1746-N14

 1746-N18

 1746-N04V

 1746-NT4

1771 PLC-5  1771-DE  1771-NIV

 1771-IFE-16CH (in single-ended 16 
Channel configuration)

 1771-NOC-noBTR

 1771-IFE-8CH (in differential 8 
Channel configuration)

 1771-NOC

 1771-IL-Alarms  1771-NOV-noBTR

 1771-IL  1771-NOV

 1771-IR  1771-NR

 1771-IXE  1771-OFE-diag

 1771-NIV-Alarms  1771-OFE

1794 FLEX  1794-IE4XOE2  1794-OE4

 1794-IE8



The 1756-RIO Module-Getting Started        Chapter 1
1756-RIO Module 
Components

The 1756-RIO module components include a 4-character display, status 
indicators, an RTB connection, and an inside-door label. 

1756-RIO/B Module

1756-RIO/A Module

RIO   CLX    OK

1

2

44777

1

2

3

4

43161

Note that the 3-pin connector 
has been changed.

1

2

RIO   CLX    OK

43161A44777A

1

2

3

4
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Chapter 1        The 1756-RIO Module-Getting Started
Item Description

1 4-character scrolling display

2 Three status indicators

 RIO indicates the status of the network

 CLX indicates the status of the connection to the controller

 OK indicates the module’s own internal state

3 3-pin connector (blue hose) that connects to the remote devices 

This is also known as the removable terminal block (RTB).

4 Inside-door label with error codes
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The 1756-RIO Module-Getting Started        Chapter 1
1756-RIO Module 
Requirements

The requirements for the module to operate include the installation of:

 RSLogix 5000 programming software, version 17 or later, and the 
associated controller firmware.

 RSLinx software, version 2.54 or later, with an activation. Use RSLinx 
Gateway or RSLinx Professional software. Do not use RSLinx Lite 
software. 

 the 1756-RIO module add-on profile from the CD provided with the 
module.

 the 1756-RIO module installed in a 1756-ControlLogix chassis.

The 1756-RIO Modes The 1756-RIO module can be used in various capacities depending on the 
user’s needs. First, decide which mode you want the 1756-RIO module to use. 

In most cases, the module is used in scanner mode to scan and control remote 
I/O data on a network. 

In adapter mode, the 1756-RIO module can perform two functions 
simultaneously. First, the module can emulate one or more racks of I/O to a 
scanner, exchanging data with that scanner (for example, a PLC-5, PLC-3, or 
SLC). It can exchange data with the scanner as discrete data, or via block 
transfers.

Second, the 1756-RIO module can act as a ‘shadow,’ referred to as Monitor 
mode, to monitor racks on a remote network. The module listens to the 
remote I/O and provides all inputs and outputs from the existing scanner to 
the ControlLogix controller. Users can then run their converted logic against 
those inputs, generate temporary outputs, and compare the existing outputs 
with outputs generated by the new logic. 
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Chapter 1        The 1756-RIO Module-Getting Started
Prepare the Module The following list summarizes the initial steps needed to prepare the 1756-
RIO module before setting up the remote network. These steps will be 
discussed in detail in this chapter.

You can have only one scanner per RIO network. Remove any other scanners 
on the RIO network before continuing. The RIO module ships in scanner 
mode. You can adjust the instructions to fit the mode that matches your needs.

1. Install RSLinx software, version 2.54 or later, with an activation. Use 
RSLinx Gateway or RSLinx Professional software. Do not use RSLinx 
Lite software.

2. Install RSLogix 5000 programming software, version 17 or later, and the 
associated controller firmware.

3. Install the 1756-RIO module in the 1756-ControlLogix chassis. 

See publication 1756-IN610.

Install the 1756-RIO module’s add-on profile found on the installation 
CD shipped with the module, or download it from http://
support.rockwellautomation.com/controlflash/LogixProfiler.asp. 

RSLinx software and RSLogix 5000 programming software must be 
installed before the add-on profile.

See page 19. 

4. Create a project in RSLogix 5000 programming software. 

5. Add a 1756 controller to your project. 

See page 23.

6. Add a 1756-RIO module to the project by right-clicking on the chassis 
in the Controller Organizer and selecting New Module. 

The Select Module dialog box appears. 

7. Expand the Communications heading and select the 1756-RIO module. 
Click OK.

See page 24.

8. Select the General tab on the Module Properties dialog box to set the 
module properties. 
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9. Enter the module name and slot number. 

See page 24.

10. Click the Change button in the Module Definition section. Select your 
desired mode, scanner or adapter. 

The module ships in scanner mode. Note the number of input/output 
tags. If this number is not the same after you map your data with the 
configuration tool, you will have to return to this screen and change 
them to match your configuration. You can specify independently the 
number of input and output tags within the range of 1…10. Each tag 
you create will create a block of 248 integers. For example, a value of 2 
will create 2x248, or 498 integers. 

11. When done, click OK on the Module Definition dialog box.

See page 25. 

12. Select the Connection tab on the Module Properties dialog box.

13. Set the Requested Packet Interval (RPI). 

See page 27.

14. Click on the Remote I/O tab, name the RIO file, and click the OK 
button. 

15. Choose Yes on the Create dialog box.

See page 31.

This will close the Module Properties dialog box. You will need to 
double-click on the 1756-RIO module in the controller organizer to re-
open the Module Properties dialog box. 

16. Click on the Configure Remote I/O Devices button on the Module 
Properties dialog box to launch the configuration tool.

17. In the configuration tool, if needed, under the Tools menu, select Set 
1756-RIO Module Scanner/Adapter Mode menu to match the RIO 
module functionality to match your application, Scanner or Adapter.

See pages 33.

18. Configure the RIO module to match your application. In scanner mode, 
add the desired racks to scan, and any block transfer modules. In adapter 
mode, configure the desired racks to be emulated, or monitored, and 
add any block transfer modules. Map all entries, either manually, or by 
using the Automap command.

See pages 51 and 76.
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19. Download the configuration to the module. From the configuration 
tool’s Configure menu, select Download Configuration. Set the 
communication path when prompted.

See page 91.

20. Save the project.

21. Go online in the RSLogix 5000 project and download the configuration 
to the controller.

See page 30.

See Chapters 2 and 3 for in-depth information on setting module modes and 
configuration. 
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Install the Software Begin by installing the RSLinx software, version 2.54 or later, with an 
activation, on your computer. You must use RSLinx Gateway or RSLinx 
Professional software. Do not use RSLinx Lite software.

Then, install RSLogix 5000 programming software, version 17 or later, and the 
associated controller firmware. 

Install the 1756-RIO module in the 1756-ControlLogix chassis.

See publication 1756-IN610.

Install the Add-on Profile Installing the add-on profile also installs the software configuration tool. The 
add-on profile and the configuration tool (56RioCfg) are on the CD that ships 
with your module. 

Once loaded onto your computer, the configuration tool is accessible within 
the RSLogix 5000 add-on profile. The configuration tool contains two separate 
programs; one for scanner mode, 56RioCfgScan; and one for adapter mode, 
56RioCfgAdpt. The program that launches depends on which mode you 
select.

With the configuration tool, you can:

• change modes.

• set the baud rate.

• autoconfigure racks from an attached Remote I/O network.

• manually add and configure racks.

• add and configure block transfer modules.

• map I/O data to the ControlLogix controller produced/consumed 
connections.

• save and load configuration files.

• download and upload configurations.

• archive projects.

• monitor diagnostics, rack status, discrete data, and block transfers. 

IMPORTANT The 1756-RIO module requires RSLogix 5000 programming 
software, version 17, or later. The add-on profile does not work 
with previous versions of RSLogix 5000 programming software.
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To install the add-on profile along with the configuration tool, follow these 
steps.

1. Make sure any instances of RSLogix 5000 programming software is shut 
down before beginning.

2. Insert the CD that was shipped with your module into your computer. 

3. Open the folder 1756-RIO Configuration Tool Setup. Run the 
MPSetup.exe program.

The RSLogix 5000 Module Profiles Setup Wizard launches. 

4. Follow the prompts to complete the installation. Click Next. Accept the 
License Agreement, install the profile, and begin. 

ATTENTION If you get a message about DTL32.DLL when installing or 
running the programs on the configuration CD, it indicates 
problems with the RSLinx software installation. Confirm that 
you have the correct version of RSLinx software. RSLinx Lite 
software cannot be used.
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5. On the Module Profiles Setup dialog box, click Install to configure 
RSLogix 5000 Module Profiles.

6. Click Next.
Publication 1756-UM534B-EN-P - November 2010 21



Chapter 1        The 1756-RIO Module-Getting Started
7. Click Finish.

Create the RSLogix 5000 
Project

Once the add-on profile is installed, you are ready to create the RSLogix 5000 
project. In this section, you will:

 start a new project.

 configure the controller in the project.

 add the 1756-RIO module to the project.

 enter the requested pack interval (RPI).
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Configure the Controller

1. Launch RSLogix 5000 programming software, if it is not opened.

2. In the RSLogix 5000 programming software Controller Organizer, from 
the File menu, choose New.

3. On the New Controller dialog box, select a 1756 controller, the Revision 
number, Name, Chassis Type, and Slot number. The 1756-RIO module 
can only be used in RSLogix 5000 programming software, version 17, or 
later.

4. Click OK.
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Add the 1756-RIO Module

1. On the Controller Organizer, right-click on the I/O Configuration 
folder and select New Module from the pull-down menu.

2. On the Select Module dialog box, expand the Communications tab and 
select the 1756-RIO module.

3. Click OK.

The 1756-RIO Module Properties dialog box displays.

IMPORTANT You must be offline to add the module to the I/O configuration 
in the RSLogix 5000 project.
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On the Module Properties dialog box, from the General tab, you can 
assign the module name, description, slot number, and module 
definition.

The Module Definition dialog box displays.

4. Click OK on the Module Definition dialog box. 

5. Click Yes to accept any changes.

6. Click OK again on the bottom of the General tab.

Item Description

Name Choose a name that easily identifies the module.

Description The Description field is optional.

Slot The Slot field must match the slot number of the 1756-RIO module’s location in the chassis.

Module Definition-
Change … button

Click on the Change … button to change the Series, Revision, Electronic Keying, Mode (scanner or adapter), 
or Number of Input or Output Tags. The Module Definition dialog box displays. 
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Module Definition Dialog Box

Item Description

Series Module series letter.

Revision Firmware revision number.

Electronic Keying Exact Match: requires all keying attributes of the physical module and the module created in the software to 
match precisely to establish communication.

Compatible Module: the module determines whether to accept or reject communication. Compatible Keying 
allows the physical module to accept the key of the module configured in the software, provided that the 
configured module is one the physical module is capable of emulating. This is the default setting.

Disabled Keying: indicates the keying attributes are not considered when attempting to communicate with a 
module. Be extremely cautious when using this option; if used incorrectly, this option can lead to personal injury 
or death, property damage, or economic loss.

Mode - Scanner or 
Adapter

The module ships in scanner mode. (The 4-character display on the front of the module also indicates which mode 
is set.) If you want to change the mode setting, you must first select the desired mode in the add-on profile on the 
Module Definition dialog box from the pull-down menu, so that the correct configuration tool starts. Then, on the 
Remote I/O tab, you must click on the Configure Remote I/O devices button (the configuration tool), and select the 
Tools menu>Set 1756-RIO Module/Scanner mode to download the correct firmware.

Be aware that changing the module mode downloads firmware specific to the mode chosen. This mode setting 
must match between the RSLogix 5000 programming software project and the configuration tool, but keep in 
mind that the correct firmware must also be downloaded. 

Input Tags - Output 
Tags

Up to 10 input and output tags can be selected. Each tag is 248 words. The number of input/output tags entered 
in the add-on profile’s Module Properties has to be equal or greater than the number of tags in the configuration 
tool.

The number of tags in the configuration tool are determined by the mappings you create. The more tags you have, 
the more backplane traffic is generated. It’s best to keep the number of tags low, which is what the automatic 
mapping command does, by mapping the data and packing it into the lowest number of tags.

For example, a single rack with discrete data that has the inputs/outputs mapped to block 9 requires the input/
output tags to be 10. So, in the Module Properties>General tab>Module Definition>Change button, select 10 for 
the number of input and output tags.
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Enter the RPI

To set the RPI, follow these steps.

1. On the controller organizer, double-click on the RIO module. 

2. On the Module Properties dialog box, from the Connection tab, set the 
RPI for the module. 

IMPORTANT If you are using the 1756-RIO module in a remote rack, for 
example, a rack connected to the controlling ControlLogix 
controller over ControlNet or Ethernet/IP, it may be necessary to 
increase the RPI, as the intermediate network may not have 
sufficient bandwidth to support faster updates (small RPIs). The 
likelihood of having bandwidth issues is increased as you 
increase the number of 248-word input and output tags.
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Remote I/O Update Time

The remote update time is the time it takes the Remote I/O scanner to scan all 
of the adapters in its I/O scan list.

The scan rate is the approximate time it takes to scan a 16-slot logical chassis 
without block transfers. The number and sizes of block transfers can 
significantly affect this time.

So, for example, if you have eight adapters on your network and your baud rate 
is 230.4 K, your approximate remote I/O update time would be 8 (# of 
adapters) * 3 ms (scan rate), or, 24 ms.

RPI

The Requested Packet Interval (RPI) specifies the rate at which the 1756-RIO 
module and the ControlLogix controller exchange data to and from each 
other. The allowable RPI’s range is from 2…750 ms, with a default of 20 ms. 
When the specified time frame elapses, the 1756-RIO module and the 
ControlLogix controller produce data for each other. All 1756-RIO input and 
output tags update with the same RPI.

Select an RPI for your application. For most applications, a good rule of 
thumb would be to set the RPI equal to one half of the remote I/O scan time.

Baud Rate Scan Rate

230.4 K 3 ms

115.2 K 5 ms

57.6 K 8 ms
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Throughput

When using the 1756-RIO module, your system throughput is based on the 
following key factors:

 Number and sizes of adapters

 Number and sizes of block transfer modules

 Overall remote I/O update time

 RPI

 Any network cards involved

 Controller scan time

 The asynchronous nature of the RPI and the remote I/O scan 

Since the RIO scan is asynchronous to the RPI, the worst case, or maximum 
update time to get information from the 1756-RIO into the controller is the 
RPI plus two times the remote I/O update rate.

You can use the diagnostic functions of the 1756-RIO configuration tool’s 
utilities to measure the average, minimum, and maximum update times on the 
Remote I/O network.
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Set Communication Path 
and Download to the 
Controller in the RSLogix 
5000 Project

Follow these steps to set the communication path and download to the 
controller.

1. On the main menu, from the Communications menu, select Who 
Active.

2. Browse to the controller.

3. Click the Set Project Path button.

4. Click Download.

Launch the Configuration 
Tool and Select the Module 
Mode

Once the desired module mode is set in the RSLogix 5000 module properties, 
you must select the mode in the configuration tool to download the correct 
firmware. You must first launch the configuration tool and then verify the 
mode setting matches in the Module Properties and in the configuration tool. 
The correct firmware must be downloaded for the module to run correctly.

ATTENTION If your desired mode is scanner mode, you do nothing at this 
point, as the module ships in scanner mode.

IMPORTANT The controller must be in Program Mode to continue with the 
firmware update.
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Launch the 1756-RIO Configuration Tool

Follow these steps to launch the configuration tool and to set the mode in the 
configuration tool.

1. On the Module Properties dialog box, click the Remote I/O tab.

2. On the Remote I/O tab window, in the RIO File (.rio): field, type a file 
name, or use the Browse button. 

The file name can include a path. If the file or directory does not exist, it 
is created.    

3. Click OK.

The following dialog box appears.

The Configure Remote I/O 
Devices button is not active.

ATTENTION When you create a file, the default location is the project 
directory. If you enter a path or file that does not exist, it is 
created. The file is not created until you run the configuration 
tool. You can use the browse button to select a location. If you 
change the path, you must click Apply before you can use the 
Configure Remote I/O Devices button.
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4. Click Yes. The Module Properties dialog box closes.

5. On the controller organizer, double-click on the 1756-RIO module to 
re-open the Module Properties dialog box. Select the Remote I/O tab.

Notice that the Configure Remote I/O Devices button is now active.

6. Click the Configure Remote I/O Devices button to launch the 
configuration tool.

The 56RioCfgScan dialog box displays. You are now in the 
configuration tool software for scanner mode. You can change 
operating modes and configure a Remote I/O network.

The Configure Remote I/O 
Devices button is now active.

TIP If you want to change operating modes, you should do this 
before configuring the module’s settings. When you change the 
operating mode, you are downloading the latest firmware to 
the module. The firmware is specific to the mode you choose, 
scanner or adapter.

IMPORTANT Notice that because ‘Scanner’ mode was set in the RSLogix 
5000 programming software on the General Tab of the RIO 
Module Properties dialog box, the scanner program within the 
configuration tool (56RioCfgScan) starts and displays at the top 
of the profile’s dialog box. 
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7. On the 56RioCfgScan dialog box, from the Tools menu, choose Set 
1756-RIO Module Scanner/Adapter Mode.

8. On the RSLinx Path Selection dialog box, click the Autobrowse box to 
browse the path to the 1756-RIO module to set the communication 
path and click OK.

The configuration tool then displays the current mode in the 
56RioSetMode dialog box and lets you select the mode you want to use.

The 56RioCfgScan program 
title displays at the top of the 
configuration tool’s dialog box 
indicating that scanner mode 
was chosen in the module’s 
properties in the RSLogix 5000 
add-on profile, and that you 
are running the scanner 
configuration tool’s firmware.

IMPORTANT Remember, specific firmware downloads, depending on mode 
selection. Also, you are prompted to reset the communication 
path when changing from one mode to another.
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In the 56RioSetMode dialog box, select the mode from the New Mode pull-
down menu and click OK to download the new firmware.

A status window displays showing the progress of the mode change. 

The 1756-RIO SetMode Confirmation dialog box displays the version 
of the firmware it is about to download. Check carefully that this 
firmware version is correct.

IMPORTANT Steps 9 and 10 change the configuration of the RIO module 
between adapter and scanner mode. If your module is 
configured for the desired mode, these steps are not necessary.

IMPORTANT Changing the 1756-RIO module mode or updating firmware 
clears the remote I/O configuration stored on the 1756-RIO 
module. 
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9. Click OK to download the firmware. 

Once you click OK, the words ‘Firmware Update’ scroll across the front 
of the 1756-RIO module’s 4-character display indicating that the 
firmware change is taking place.

The tool downloads the firmware and displays the progress of the 
download. When the download is complete, the tool displays the result 
of the download. The 1756-RIO SetMode Completed Successfully 
dialog box appears. 

10. Click OK. 

The front of the 1756-RIO module’s character display should now 
indicate the new firmware mode.

If the download fails, the tool displays an error message.
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Chapter 2

Configure Scanner Mode

Introduction Once the 56RioCfg configuration tool launches, you can configure a Remote 
I/O network using the RIO module as a scanner, or an adapter. This chapter 
describes how to configure the module for use in scanner mode.

In scanner mode, the ControlLogix controller writes remote I/O outputs and 
reads remote I/O inputs. The 1756-RIO module enables communication 
between the controller and devices on a Remote I/O network. The scanner 
continuously scans the adapters on the Remote I/O network.

Two types of data are transferred over the Remote I/O network - discrete and 
block transfer data. Discrete data transfers consist of the scanner sending 
output data and communication commands to the adapter, which instruct the 
adapter about how to control its output. The adapter responds by sending 
input data to the scanner. 

The remote I/O block transfer module is a data transfer mechanism that lets 
you control the transfer of up to 64 words of data to or from a remote device. 
The 1756-RIO module allows the user to offload block transfer execution 
from the controller. The data appears in the data table of the ControlLogix 
controller without having to execute the logic in the controller to perform the 
block transfer. A Block Transfer Read (BTR) receives data from a remote 
device. A Block Transfer Write (BTW) sends data to a remote device.

In this chapter, you use the configuration tool to configure the module in 
scanner mode to prepare it for use on the Remote I/O network. You will:

• configure the racks automatically, or manually.

• add and configure block transfer modules.

• map the remote I/O modules to the ControlLogix controller produced/
consumed data.
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Configure Scanner 
Summary

The following list summarizes the steps to configure the 1756-RIO module in 
scanner mode.

1. Set the baud rate.

2. Autoconfigure online racks on the network. (Make sure the controller is 
set to Program Mode.)

3. Set the communication path.

4. Manually add any additional racks that are not online.

5. Manually add and configure block transfer modules.

6. Map/Automap the data.
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Set the Baud Rate After setting the operating mode for the 1756-RIO module, you must set the 
baud rate. 

1. On the 56RioCfgScan dialog box, right-click on the controller on the I/
O tree and from the pull-down menu, select 1756-RIO Properties. 

The 1756-RIO Properties dialog box displays.

2. Select the baud rate.

3. You can also optionally enter an LED Banner name. 

This is a unique name you assign to identify the module. This is useful 
when you have multiple RIO modules on your network. The LED 
Banner displays on the 4-character display on the 1756-RIO module. It 
can be from 0…15 characters long.

4. Click OK.

You must perform a download to reconfigure the module. 

Value Baud Rate, Kbps

57 k - scanner mode default 57.6

115 k 115.2

230 k 230.4

TIP If you perform an autoconfiguration, the 1756-RIO module 
automatically detects the baud rate by sending packets to an 
attached remote I/O network.
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5. On the main menu, from the Configure menu, choose Download, or 
click the Download Config to Module button on the toolbar.

Autoconfigure Racks You can autoconfigure racks attached to the network, or add additional racks 
manually. The Autoconfigure command scans the Remote I/O network to 
determine which racks are present.

The module automatically detects the network baud rate and configures the 
racks on the attached Remote I/O network.

The 56RioCfgScan tool sends messages to all possible racks, detects all 
possible baud rates, and from the replies, determines which racks are on the 
network. 

Main Menu

Toolbar
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The icons on the 56RioCfgScan tool show the partial rack sizes and locations. 
Racks are shown with starting and ending I/O groups. For example, the 
following tree shows rack 0 consisting of 4 quarter racks.

Block transfer modules must be added and configured manually. 

When the module is in scanner mode, the 1756-RIO module performs the 
following actions during autoconfigure. The module:

• detects the network baud rate by sending messages at each baud rate, 
looking for responses.

• then sends messages to all possible racks on the network.

• builds a network configuration from the observed network responses.

• displays the network configuration.

Partial Rack (1/4 rack)

Rack 0

IMPORTANT The controller with the connection to the 1756-RIO module 
must be in program mode when you perform an 
autoconfiguration. The following error message displays if the 
controller is not in program mode.
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To perform an autoconfigure in scanner mode, follow these steps.

1. On the main menu, from the Configure menu, select Autoconfigure, or 
click the Autoconfigure button on the toolbar.

Any configuration previously stored in the 1756-RIO module is overwritten by 
the data from the autoconfiguration. You are given the option to save the 
previous configuration before it proceeds with the autoconfiguration. 

Autoconfiguration detects just the rack structure, it cannot locate block 
transfer modules. You have to manually add block transfer modules to the 
rack.

TIP There is no specific ’auto’ baud rate when the module is in 
scanner mode. When using autoconfigure, the 1756-RIO module 
tries all three baud rates and sets the baud rate based on the 
responses to the messages it sends. You need to make sure that 
all devices on the network are set at the same baud rate.

TIP After performing an Autoconfigure, what displays by the 
56RioCfgScan tool matches what is in the 1756-RIO module. No 
download is necessary. The Autoconfigure also automatically 
maps the discrete rack data to tags in the ControlLogix 
processor.

Main Menu

Toolbar
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Manually Configure Racks To add a rack manually to the remote I/O configuration, follow these steps.

1. On the 56RioCfgScan dialog box, right-click on the root of the I/O tree, 
which represents the remote I/O scanner, and select Add Rack from the 
pull-down menu.

The Add/Resize Rack dialog box displays.

2. On the Add/Resize Rack dialog box, select the Rack number (in octal), 
the Start Group, and the End Group.

3. Click OK.

Item Field Description Range

1 Rack 0…76 octal available.

2 Start Grp (I/O) 0,2,4,6.

A logical rack consists of eight I/O groups, numbered 0…7. The smallest unit allowed on a 
network is a quarter rack, so the starting I/O groups are 0,2,4,6.

3 End Grp (I/O) 1,3,5,7.

Ending I/O groups.
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Matching Configuration Tool Settings with Module Settings

After manually adding a rack, a download is necessary. 

To download to the module, from the Configure menu, select Download 
Configuration; or, from the toolbar, click the Download Config to Module 
button.

Manually adding racks also requires the discrete data to be mapped to tags in 
the ControlLogix controller before allowing a download. The data can be 
mapped automatically or manually. 

See Map I/O Data on page 51.

Main Menu

Toolbar
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Resize a Rack

To resize a configured rack, follow these steps.

1. On the 56RioCfgScan dialog box, right-click on the rack in the I/O tree 
and choose Resize Partial Rack from the pull-down menu. 

The Add/Resize Rack dialog box displays.

2. Select Start Group and End Group.

3. Click OK.

If resizing the rack results in an overlap with an existing rack, the resize 
fails and displays an error message.

If resizing the rack results in deleting block transfer modules, you are 
given the option of cancelling the resize, or proceeding and deleting the 
block transfer modules.
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Delete a Rack

To delete a rack, follow these steps.

1. On the 56RioCfgScan dialog box, right-click on the rack in the I/O tree 
and choose Delete Rack(s).

2. To delete a partial rack, expand the rack in the I/O tree, right-click on 
the partial rack and choose Delete Partial Rack.

Configure Block Transfer 
Modules

All block transfer modules represent some type of analog data. Block transfer 
modules transfer a block (64 words maximum) of analog-type data at a rate 
configured by the user. The 1756-RIO module lets the user offload block 
transfer execution from the controller to the 1756-RIO module. 

If a slot is occupied by a discrete I/O module, or is empty, select ‘Discrete’, 
which is the default. If a specific block transfer module occupies the slot, select 
the part number of that block transfer module.

Not all block transfer modules are supported directly by the 1756-RIO 
module. If the module you are using does not appear in the list, set the module 
type to BT-MODULE and set the lengths to the appropriate values. In some 
cases, there are multiple templates for a given block transfer module to show 
that the module can be used in significantly different ways.

See Appendix D for additional information on block transfer templates.
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All block transfer data is mapped into one of the possible 10 produced/
consumed connections on the controller. Each produced/consumed 
connection allows 248 16-bit words, in and out. There are two words of 
overhead for each block transfer for control/status. The 1756-RIO module 
can execute as many block transfers as the user configures up to the limits of 
available memory mapped to the ControlLogix controller.

To configure a block transfer module, follow these steps.

1. On the 56RioCfgScan dialog box, expand the I/O tree to choose the 
location where you want to add the module.

2. On the I/O tree, right-click the slot where you want to add the module 
and select Module Properties.

IMPORTANT Block transfers do not need MSG instructions to execute.

TIP In scanner mode, block transfer modules can be configured 
manually, also.
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3. On the I/O Module Properties dialog box, from the Module Type pull-
down, select the type. 

4. Click OK.

The I/O Module Properties dialog box displays. 

5. Click Configure to display the BT Module Parameterization 
configuration dialog box to configure the module.

This example shows the BT Module Parameterization dialog box for a 
16-channel 1771-IFE module. Each module is different. 

Use the dialog box to set parameters for a block transfer module. These 
parameters are defined in the template file for the block transfer module 
and are typical quantities, such as scaling parameters, and alarms. 

Module Types

Type Description

Discrete A block transfer module does not exist at this location.

BT-MODULE Any other block transfer module not listed by part number in the system.

1746-xxx…1794-xxx Part number of block transfer (analog) modules with template files in the system that are compatible with the 
1756-RIO module. See Supported Modules on page 12 for the complete list.
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6. Enter the configuration data and click OK.

7. On the I/O Module Properties dialog box, select how you want the 
block transfer to update. 

There are three update modes: automatic, semi-automatic, and manual.
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8. On the I/O Module Properties dialog box, select the block transfer 
read-and-write-update rates, from 0…16,383 ms. 

A rate of 0 means the 1756-RIO module updates the block transfer as 
fast as the network and the block transfer module allows.

Type Description

Automatic 1756-RIO module controls block transfer update.

Automatic block transfers perform a single configuration block transfer write every time the controller 
transitions from Program to Run mode and then perform timed data block transfer read and write updates using 
the BTR and BTW data lengths and times from the configuration tool. The length values and update times for 
automatic block transfers all come from the configuration tool.

Automatic block transfers begin as soon as the controller is in run mode; they do not have to be triggered.

Errors in block transfer execution are indicated by non-zero values returned to the ControlLogix controller.

In automatic mode, the module configuration data values come from the configuration tool as default values, or 
from user parameters. The size of the configuration block transfer write is the data BTW length, BtwLen, plus 
the Config BTW Length, CfgLen, from the template. The data block transfer write length is BtwLen from the 
template and this is the length mapped to ControlLogix output data.

The size of the data block transfer read is set by the configuration tool.

Semi-automatic 1756-RIO module controls block transfer update.

Semi-automatic block transfers perform a single configuration block transfer write every time the controller 
transitions from Program to Run mode and then perform timed data block transfer read and write updates using 
the BTR and BTW data lengths and times from the configuration tool. The length values and update times for 
semi-automatic block transfers all come from the configuration tool.

Semi-automatic block transfers begin as soon as the controller is in run mode; they do not have to be triggered.

Any errors in BT execution are indicated by non-zero values in the ControlLogix controller.

In Semi-automatic mode, the module configuration data values come from ControlLogix output data. The size of 
the configuration block transfer write is the data BTW length, BtwLen, plus the Config BTW Length, CfgLen, 
from the template, and this is the length mapped to ControlLogix output data. The data block transfer write 
length is BtwLen from the template.

The size of the data block transfer read is set by the configuration tool.

Manual The ControlLogix controller controls block transfer update.

I/O module configuration gathers data from the ControlLogix controller.

To execute block transfers in manual mode:

 enter the BTR and/or BTW length and BTW data in the control block for the module.

 set the BTR.EN and/or BTW.EN bits (BTR.CONT/BTW.CONT) for continuous execution.

 check the BTR.DN/BTW.DN bits that indicate BT execution is complete (BTR data is available at that time).

 check the BTR.ERR/BTW.ERR bits. If set, read the error code to determine the cause of the problem. 

Inhibit Automatic Block 
Transfers

To inhibit a running automatic, or semi-automatic block transfer, set bit 9 to offset 0 of the mapped output data 
for the module.
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Map I/O Data You must map the I/O data to locations in the ControlLogix controller input 
and output data before you can scan the Remote I/O network.

Mapping connects locations in the ControlLogix input and output tags to 
locations on the Remote I/O network (discrete data on racks and block 
transfer reads and writes.)

Connections (produced/consumed) occur between the 1756-RIO module and 
the ControlLogix controller. They are point-to-point links between two end 
points. 

Produced/consumed tag data is the information that gets passed back and 
forth over the line between the two end points.

There are up to 10 blocks of produced/consumed tag data. Discrete and block 
transfer tag data gets ‘packed’ into the ControlLogix produced/consumed 
data. When discrete and block transfer tag data are mapped, or when the 
configuration tool ‘auto maps’ the data for you, you are selecting which of 
those blocks the tag data is mapped to, and the offset in the block where the 
tag data is found.

See Scanner Mode I/O Map on page 129.

When mapping is complete, you must export the aliases to the 1756-RIO 
module and import the configuration to the RSLogix 5000 project.

See Aliases on page 84, for a complete discussion of exporting and importing 
aliases. 

IMPORTANT It is essential that the control program on the host controller 
matches the addresses in the mapping configuration on the 
1756-RIO module, otherwise the control program may 
inadvertently write to the incorrect I/O locations. If you change 
the data mappings on the 1756-RIO module, make sure that the 
control program uses the correct addresses.
Publication 1756-UM534B-EN-P - November 2010 51



Chapter 2        Configure Scanner Mode
ATTENTION
Unassigned, or unmapped, data (I/O addresses) are shown as 
xxx in the I/O tree.

IMPORTANT If you change mappings, make sure you clear the output table in 
the ControlLogix controller to prevent inadvertently writing to 
an incorrect I/O location. If you leave a value behind in the 
output table, it now points to something else on the Remote I/O 
network. To clear the output table, set the outputs to 0. You 
must also re-import the aliases.

Unmapped Data

Mapped Data
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Automatic Mapping

The Auto Map Any Unassigned command automatically maps any unassigned 
discrete or block transfer data to ControlLogix connections. Discrete data is 
mapped before block transfer data. The longest blocks of data are mapped 
first, from the lowest addresses up. Any previously-assigned addresses remain 
unchanged. 

On the 56RioCfg configuration tool dialog box, from the Map menu, choose 
Automap Any Unassigned to automatically map all the data. 

Any xxxs are replaced with an actual I/O address.

Manually Map Discrete (rack) Data

1. On the 56RioCfgScan dialog box, right-click on the rack, and select 
Rack Map Discretes - Assign Manually.
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2. On the Map Rack…Manually dialog box, from the CLX Block pull-
down menu, select the ControlLogix block and Data Offset within the 
block for the Input Mapping and Output Mapping.

Data Offset Field Range Choices

3. Click OK to accept the mapping.

The configuration tool checks for overlaps with previously-mapped data and 
displays an error if it finds an overlap.

Item Field Description

1 Clx Block There are up to 10 data blocks (0…9) available on the ControlLogix controller for inputs and outputs. You select 
the block where the data is ’packed’.

2 Data Offset The data offset (0…247) is the area in the data block where the input/output data is found.You select the data 
offset area within the block.

1
2
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Manually Map Block Transfer Data

1. On the 56RioCfgScan dialog box, from the expanded rack list, right-
click on the module and select BT Module Clx Map - Assign Manually.

2. On the Map BT Module…Manually dialog box, from the CLX Block 
pull-down menu, select the ControlLogix block and Data Offset within 
the block for the Input Mapping and Output Mapping.

3. Click OK to accept the mapping.

The configuration tool checks for overlaps with previously-mapped data and 
displays an error message if it finds an overlap.

If there is insufficient space in the current block to map the data:

• the Data Offset field is blank.

• the OK button appears dimmed.

Change the block number and select an offset.
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Re-Map Command

Use the Re-Map All command to clear all previous mappings and 
automatically map all discrete and block transfer data to connections. 

From the Map menu, select Re-Map All.

See Aliases on page 84, for exporting and importing aliases. 

IMPORTANT If you change mappings, make sure you clear the output table in 
the ControlLogix controller to prevent inadvertently writing to 
an incorrect I/O location. If you leave a value behind in the 
output table, it now points to something else on the Remote I/O 
network. To clear the output table, set the outputs to 0. You 
must also re-import the aliases.

ATTENTION If you remap I/O data, you should export aliases and re-import 
them into the RSLogix 5000 project so the control program uses 
the new assignments.
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Clear Mappings

Follow these steps to clear all mappings.

1. To clear all assigned mappings, on the 56RioCfgScan dialog box, from 
the Map menu, choose Clear All Mappings.

2. On the Clear ALL Mappings dialog box, confirm that you want to clear 
all the existing mappings and click Yes. 

IMPORTANT If you change mappings, make sure you clear the output table in 
the ControlLogix controller to prevent inadvertently writing to 
an incorrect I/O location. If you leave a value behind in the 
output table, it now points to something else on the Remote I/O 
network. To clear the output table, set the outputs to 0. You 
must also re-import the aliases.
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Clear Discrete Rack Data Mappings

Follow these steps to clear mappings for discrete (rack) data.

1. On the 56RioCfgScan dialog box, right-click on the rack and select Rack 
Map Discretes - Clear.

2. On the Clear Rack Map dialog box, confirm that you want to clear the 
existing mappings and click Yes. 

IMPORTANT All of the preceding mapping and configuration examples 
currently reside only within the 56RioCfgScan software and 
must be downloaded to the 1756-RIO module. 

See page 30 for download steps.
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Clear Block Transfer Module Data Mappings

Follow these steps to clear the mappings for block transfer data.

1. On the 56RioCfgScan dialog box, from the expanded rack, right-click 
on the block-transfer module and select BT Module Clx Map - Clear.

2. On the Clear BT Module Map dialog box, confirm that you want to 
clear the BT Module mappings, and click Yes.

 

Publication 1756-UM534B-EN-P - November 2010 59



Chapter 2        Configure Scanner Mode
Notes:
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Configure Adapter Mode

Introduction This chapter explains how and why to use the 1756-RIO module in adapter 
mode. In adapter mode, the 1756-RIO module can perform two functions 
simultaneously. 

First, the module can emulate one or more racks of I/O to a scanner, 
exchanging data with that scanner (for example, a PLC-5, PLC-3, or SLC 
controller). On Active racks, the module writes remote I/O inputs and reads 
remote I/O outputs. 

Second, it can monitor other remote I/O racks. On Monitored racks, the 
1756-RIO module can monitor existing I/O, also known as ‘Monitor mode,’ 
and can be used to upgrade a PLC-5, PLC-3, or SLC system to a ControlLogix 
system. Monitor mode provides existing discrete inputs and outputs, and 
Block Transfer reads and writes to the ControlLogix controller.

See Scan Mode and Monitor Mode on page 99 for a complete description of 
using Monitor mode. 

The 1756-RIO module communicates with the ControlLogix controller using 
up to 10 input connections and 10 output connections via produced/
consumed data. Remote I/O data maps into the connections by the 
configuration tool. 

In this chapter, you use the configuration tool to configure the module in 
adapter mode to prepare it for use on the Remote I/O network. You will:

• configure the racks automatically or manually.

• add and configure block transfer modules.

• map the remote I/O modules to the ControlLogix controller produced/
consumed data.

Topic Page

Configure Adapter Summary 62

Set the Baud Rate 63

Autoconfigure Racks 64

Manually Configure Racks 69

Configure Block-transfer Modules 72

Map I/O Data 76
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                      Adapter Mode

Configure Adapter 
Summary

The following list summarizes the steps to configure the 1756-RIO module in 
adapter mode.

1. Set the baud rate.

2. Autoconfigure online racks on the network. (Make sure the controller is 
set to Program Mode.)

3. Set the communication path.

4. Manually add any additional racks that are not online.

5. Manually add and configure block transfer modules.

6. Map/Automap the data.
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Two-way 
communication 
between the RIO 
scanner and the 
1756-RIO module 
in adapter mode.

1756-RIO Module as an Active Rack 1756-RIO Module as a Monitored Rack

One-way 
communication 
between the Remote I/
O network and the 
ControlLogix controller. 
The RIO scanner 
controls the I/O and 
the ControlLogix 
controller via the 1756-
RIO module in adapter 
monitors all I/O data. 
In monitor mode, it 
monitors the I/O and 
brings all input and 
output data into the 
ControLogix controller.

44828 44829

Universal Remote I/O Network

IMPORTANT Configuring the 1756-RIO module as an adapter enables the RIO 
module to emulate a 1771-ASB module. This allows a path for 
peer-to-peer data to be exchanged between the scanner 
controller and the ControlLogix owner of the RIO module over 
the Remote I/O network. The adapter mode functionality does 
not allow the scanner controller to directly control any 1756-I/O 
in the chassis with the RIO module.
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Set the Baud Rate To set the baud rate in adapter mode, follow these steps. 

1. On the 56RioCfgAdpt dialog box, right-click on the controller on the I/
O tree and from the pull-down menu, select 1756-RIO Properties. 

The 1756-RIO Properties dialog box displays.

2. On the 1756-RIO Module Properties dialog box, select the baud rate.

3. You can also enter an LED Banner name. This is a unique name you 
assign to identify the module. This is useful when you have multiple 
RIO modules on your network. The LED Banner displays on the 4-
character display on the 1756-RIO module. It can be from 0…15 
characters long.

4. Click OK.

The default baud rate is Auto (automatic baud rate detection). 

Value Baud Rate, Kbps

57 k 57.6

115 k 115.2

230 k 230.4

Auto - adapter mode default Auto

TIP If you perform an autoconfiguration, the 1756-RIO module 
automatically detects the baud rate by monitoring an attached 
Remote I/O network.

TIP If you are only using Active racks, set the baud rate to match 
the Remote I/O network. Don’t set it to Auto.
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Autoconfigure Racks When the module is in adapter mode, autoconfigure builds a configuration 
based on what it has heard on a running network. This process differs from 
scanner mode, because the 1756-RIO module does not scan these racks, only 
monitors the information to and from these racks.

The module automatically detects the network baud rate and configures the 
racks on an attached Remote I/O network. Autoconfiguration detects the rack 
structure and causes the 1756-RIO module to monitor the data to and from 
these racks. Active and monitored racks are displayed.

See Active Versus Monitored Racks on the Network on page 67 for detailed 
information about active and monitored racks.

Autoconfigure in adapter mode performs the following actions:

• Detects the network baud rate

• Monitors messages to and from racks on the network

• Builds a network configuration from the observed network traffic

• Displays the network configuration

To autoconfigure in adapter mode, you must:

•  clear the old configuration.

• download a new, empty configuration.

• set the baud rate to ‘auto’, or to the baud rate that matches the existing 
network. 

• put the scanner in Run mode until all block transfers execute.

• put the scanner back in Program mode.

• perform the autoconfiguration.

IMPORTANT The controller with the connection to the 1756-RIO module 
must be in program mode when you perform an 
autoconfiguration.

ATTENTION Please note, any configuration previously stored in the 1756-
RIO module is overwritten by the data from the 
autoconfiguration. You are given the option to save the previous 
configuration before it proceeds with the autoconfiguration. 
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 Perform the AutoConfiguration

Follow these steps to perform autoconfiguration.

1. On the 56RioCfgAdpt dialog box, from the Configure menu, choose 
Download Configuration, or click the Download Configuration button 
on the toolbar. 

This clears the previous configuration and downloads an empty 
configuration to the 1756-RIO module. 

2. Set the baud rate to Auto. On the 56RioCfgAdpt dialog box, right-click 
on the controller in the I/O tree, and from the pull-down menu, select 
1756-RIO Properties to enter the baud rate. 

3. To automatically add block transfers, put the remote I/O scanner 
module in Run mode (you set it to Program mode before you began the 
autoconfiguration) and wait until the block transfers execute. Then put 
the scanner back in Program mode.

Main Menu Toolbar
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4. On the 56RioCfgAdpt dialog box, from the Configure menu, choose 
Autoconfigure to build a configuration from observed network traffic, 
or click the Autoconfigure button on the toolbar.

The RSLinx Path Selection autobrowse dialog box displays. 

5. Navigate to the backplane and select the 1756-RIO adapter module and 
click OK.

The 1756-RIO module builds a configuration based on what it has observed 
on the Remote I/O network since the download. The configuration includes 
racks, block transfer modules, and observed block transfer updates. All block 
transfers are set to type BT-MODULE.

Main Menu Toolbar
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Active Versus Monitored Racks on the Network

You must distinguish between active and monitored racks, and must manually 
enter active racks into the 1756-RIO module’s configuration, and manually add 
any desired block transfers. 

On monitored racks, the 1756-RIO module picks up the block transfers 
automatically, but must have the specific module type set. This insures that the 
aliases you create for import into the RSLogix 5000 project have names that 
better describe the data content. Otherwise, the generic module type, BT-
MODULE, is set.

If you want active racks, add them manually now, then download the modified 
configuration to the 1756-RIO module.

In the configuration tree, each rack line precedes an icon representing rack 
information. The icons represent type and size. The size, color, and position of 
the colored block indicates the location, size, and type of partial rack, and 
whether the rack is active or monitored.

Active Versus Monitored Racks

Type Description

Active The 1756-RIO module emulates one or more remote I/O racks. The ControlLogix controller sends the rack- 
produced data, which is then sent as remote I/O input data to the scanner on the Remote I/O network. The 
remote I/O scanner sends output data for those emulated racks to the 1756-RIO module in adapter mode. The RIO 
module then sends that data to the ControlLogix controller as consumed input data.

Use ‘Active’ if you want to exchange data between a ControlLogix controller and a scanner on remote I/O. You 
can also configure one or more slots in the Active rack as block transfer modules to exchange larger amounts of 
data with the remote I/O scanner. Active racks are one or more racks that the 1756-RIO module is emulating to 
share information between the existing scanner and the ControlLogix controller.

Any rack in the configuration tree that contains at least one portion of an Active rack displays with a lightning 
bolt and a red indication on the active portion of the rack. The text ‘Actlnp:Ox.Data[xxx]’ also displays, indicating 
that this data originated in the ControlLogix controller as output data that appears as input data to the remote I/
O scanner.

Monitor The 1756-RIO module monitors remote I/O inputs on an existing Remote I/O network, and passes data as 
produced/consumed data to the ControlLogix controller. This is also known as ‘Monitor mode’. Use ‘Monitor 
mode’ if you have a supervisory ControlLogix system that needs to collect data from an existing control system 
with remote I/O.

Monitored racks are racks that physically exist on the Remote I/O network and are to be monitored by the 1756-
RIO module. Any portion of a rack in the configuration tree that is configured as ‘Monitor’ displays with a blue 
indication on the rack.
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Racks are shown with starting and ending I/O groups in the I/O tree. For 
example, the following I/O tree shows rack 0 as a quarter rack starting at I/O 
group 0.

The line color denotes active or 
monitored partial rack state.

Starting and ending 
group number

Lightning bolt denotes an 
active partial rack in the rack.

Rack 00 contains four 
monitored, quarter racks, so 
no ‘lightning bolt’.

Rack Icon Information

Code Description

Lightning bolt Denotes at least some part of the rack is configured as active. Rack 
01 contains an active half rack; Rack 03 contains three monitored 
quarter racks, but also an Active quarter rack; therefore, the 
lightning bolt. 

Red Denotes that this portion of the rack is configured as active.

Blue Denotes that this portion of the rack is configured as monitored.
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Manually Configure Racks To add a rack manually to the remote I/O configuration, follow these steps.

1. On the 56RioCfgAdpt dialog box, right-click on the root of the I/O 
tree, which represents the ControlLogix controller, and choose Add 
Rack from the pull-down menu.

The Add/Resize Rack dialog box displays. 

2. On the Add/Resize Rack dialog box, choose the Rack number (in octal), 
the Start Group, the End Group, and Rack Mode (Monitor or Active).   

3. Click OK.

Type Description

Active Emulates one or more remote I/O racks. The ControlLogix controller sends the rack produced/consumed data as 
input data, which is then sent as remote I/O input data to the scanner on the Remote I/O network. The remote I/
O scanner sends output data for those emulated racks to the 1756-RIO module in adapter mode. The RIO module 
then sends that data to the ControlLogix controller as produced/consumed input data.

Use active if you want to exchange data between a ControlLogix controller and a scanner on remote I/O.

Monitor Monitors remote I/O inputs and outputs on monitored, remote I/O racks, and passes data as produced/consumed 
input data to the ControlLogix controller. This is also known as ‘Monitor mode’. Use Monitor mode if you have a 
supervisory ControlLogix system that needs to collect data from older control systems with remote I/O.
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Resizing Racks

To resize a configured rack, follow these steps.

1. On the 56RioCfgAdpt dialog box, right-click on the rack in the I/O tree 
and choose Resize Partial Rack from the pull-down menu. 

The Add/Resize Rack dialog box displays. Field options differ 
depending on mode.

2. On the Add/Resize dialog box, select Start Group and End Group.

You cannot change the Rack number or Rack type (Active or 
Monitored). The radio button is dimmed.

3. Click OK.

If resizing the rack results in an overlap with an existing rack, the resize 
fails and displays an error message.

If resizing the rack results in deleting block transfer modules, you are 
given the option of cancelling the resize or proceeding and deleting the 
block transfer modules.
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Delete Racks

To delete a rack, follow these steps.

1. On the 56RioCfgAdpt dialog box, expand the rack in the I/O tree, 
right-click on the rack in the I/O tree and choose Delete Rack(s).

2. To delete a partial rack, expand the rack in the I/O tree, right-click on 
the partial rack and choose Delete Partial Rack.
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Configure Block-transfer 
Modules

All block transfer modules represent some type of analog data. Block transfers 
send a block (64 words maximum) of data to or from an I/O module in one 
scan. 

If a slot is occupied by a discrete I/O module, or is empty, select ‘Discrete’, 
which is the default. If a specific block transfer module occupies the slot, select 
the part number of that block transfer module.

Not all block transfer modules are supported directly by the 1756-RIO 
module. If the module you are using does not appear in the list, set the module 
type to BT-MODULE and set the lengths to the appropriate values. In some 
cases, there are multiple templates for a given block transfer module to show 
that the module can be used in significantly different ways.

See Block Transfer Module Templates on page 153 for additional information 
on block transfer templates.

Block transfers can be added to active or monitored racks.

To configure a block transfer module, follow these steps.

1. On the 56RioCfgScan/56RioCfgAdpt dialog box, expand the I/O tree 
to choose the location where you want to add the module.

2. On the I/O tree, right-click the location where you want to add the 
module and select Module Properties.

The dialog boxes change depending on mode, active or monitored.

TIP On active racks, the only Module Type is BT-MODULE.
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3. On the I/O Module Properties, from the Module Type dialog box pull-
down menu, select the module type. 

You have various choices depending on the rack type.

4. Click OK.

Active Racks

1. On the I/O Module Properties dialog box, from the Module Type 
menu, select BT-MODULE. (On active racks, the only block transfer 
module type is BT-MODULE.)

Module Type Selection

Mode Description

Active In Active mode, select BT-MODULE, and then adjust the BTR Length and BTW Length to match your ControlLogix 
application. These sizes are determined by the remote I/O scanner and must match the remote I/O scanner’s 
configuration.

Monitor In Monitor mode, select the type of module that is in that location on the Remote I/O network from the pull-
down menu. If the specific module is not supported, select BT-MODULE, and adjust the sizes to match your 
ControlLogix application. These sizes are determined by the remote I/O scanner and must match the remote I/O 
scanner’s configuration.
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From the BTR Len and BTW Len pull-down menus, select the desired 
lengths. The BTR Length and BTW Length sizes are determined by the 
remote I/O scanner and must match the remote I/O scanner’s 
configuration.

2. Click OK.

Monitored Racks

1. On the I/O Module Properties dialog box, from the Module Type pull-
down, select the block transfer module type.
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2. From the BTR Len and BTW Len pull-downs, select the desired lengths. 
Select the block transfer Module Type from the pull-down menu that 
matches the module on remote I/O. If the desired module is not listed, 
select BT-MODULE. Adjust the BTR Length and BTW Length to 
match your application. These sizes are determined by the remote I/O 
scanner and must match the remote I/O scanner’s configuration.

3. Click OK. 
Publication 1756-UM534B-EN-P - November 2010 75



Chapter 3        Configure Adapter Mode
Map I/O Data You must map the I/O data to the ControlLogix controller produced/
consumed data blocks and offset locations before you can scan the Remote I/
O network. After mapping is complete, you must export the aliases to the 
1756-RIO module and import them to the RSLogix 5000 project.

See Aliases on page 84 for a detailed discussion of Exporting/Importing 
Aliases.

Unassigned I/O addresses are shown as xxx in the I/O tree.

Automatic Mapping

The configuration tool maps all unassigned I/O to produced/consumed 
inputs and outputs. It leaves any previously assigned addresses unchanged.

On the 56RioCfg configuration tool dialog box, from the Map command on 
the main menu, choose Automap Any Unassigned to automatically map the 
data. 

IMPORTANT If you change mappings, make sure you clear the output table in 
the ControlLogix controller to prevent inadvertently writing to 
an incorrect I/O location. If you leave a value behind in the 
output table, it now points to something else on the Remote I/O 
network. To clear the output table, set the outputs to 0.

Unmapped Data

Mapped Data
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Manually Map Discrete Data

Manually Map Discrete(rack) Data

1. On the 56RioCfgAdpt dialog box, right-click on the rack, and choose 
Rack Map Discretes - Assign Manually.

2. On the Map Rack… Manually dialog box, from the CLX Block pull-
down, select the ControlLogix scheduled block and Data Offset within 
the block. 

3. Click OK to accept the mapping.

TIP On monitored racks, inputs and outputs get mapped to 
ControlLogix inputs, so be careful when mapping them so that 
they don’t overlap. 

Item Field CLX Data Type Rack Type Description

1 MonOut ClxInput data Monitored/
Active

Remote I/O scanner outputs are mapped to ControlLogix controller inputs. The 1756-
RIO module monitors output data sent by the scanner to the monitored/active rack. It 
is reported in the ControlLogix controller as input data.

2 MonInp ClxInput data Monitored Remote I/O scanner inputs are mapped to ControlLogix controller inputs. The 1756-
RIO module monitors input data sent to the scanner by the monitored rack. It is 
reported in the ControlLogix controller as input data.

3 ActInp ClxOutput data Active Remote I/O scanner inputs are mapped from the ControlLogix outputs. The 
ControlLogix controller writes output tags to the 1756-RIO module, which sends the 
data to the remote I/O scanner as input data.

1
2
3
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Manually Map Block-transfer Data

1. On the 56RioCfgAdpt dialog box, from the expanded rack list, right-
click on the module and choose BT Module Clx Map - Assign Manually.

2. On the Map BT Module… Manually dialog box, for the block transfer 
read and write data, select the ControlLogix scheduled block and Data 
Offset within the block.

3. Click OK to accept the mapping.   

Block-transfer Data Map Destinations for Monitored and Active Racks

Field CLX Data Type Rack Type Description

MonBTW ClxInput Monitored Block transfer write data maps to ControlLogix controller inputs.

MonBTR ClxInput Monitored Block transfer read data maps to ControlLogix controller inputs.

ActBTR ClxOutput Active Block transfer read data maps to ControlLogix controller outputs (The ControlLogix 
controller writes the data and the 1756-RIO module sends the data to the remote I/O 
scanner.)

Block transfer write data maps to ControlLogix controller inputs.
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Re-Map Command

Use the Re-Map All command to clear all previous mappings and 
automatically map all discrete and block transfer data to produced/consumed 
data connections.

From the Map menu, choose Re-Map All.

IMPORTANT If you change mappings, make sure you clear the output table in 
the ControlLogix controller to prevent inadvertently writing to 
an incorrect I/O location. If you leave a value behind in the 
output table, it now points to something else on the Remote I/O 
network. To clear the output table, set the outputs to 0. You 
must also re-import the aliases.
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Clear Mappings

Follow these steps to clear all mappings.

1. To clear all assigned mappings, on the 56RioCfgAdpt dialog box, from 
the Map menu, choose Clear All Mappings.

2. On the Clear ALL Mappings dialog box, confirm that you want to clear 
the existing mappings and click Yes. 

IMPORTANT If you change mappings, make sure you clear the output table in 
the ControlLogix controller to prevent inadvertently writing to 
an incorrect I/O location. If you leave a value behind in the 
output table, it now points to something else on the Remote I/O 
network. To clear the output table, set the outputs to 0. You 
must also re-import the aliases.
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Clear Discrete Rack Data Mappings

Follow these steps to clear mappings for discrete(rack) data.

1. On the 56RioCfgAdpt dialog box, right-click on the rack and choose 
Rack Map Discretes - Clear.

2. On the Clear Rack Map dialog box, confirm that you want to clear the 
existing mappings and click Yes.

IMPORTANT All of the preceding mapping and configuration examples 
currently reside only within the 56RioCfgAdpt software and 
must be downloaded to the 1756-RIO module. 

See Set Communication Path and Download to the Controller in 
the RSLogix 5000 Project on page 30 for download steps.
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Clear Block Transfer Module Data Mappings

Follow these steps to clear the mappings for block transfer data.

1. On the 56RioCfgAdpt dialog box, from the expanded rack, right-click 
on the block transfer module and choose BT Module Clx Map - Clear.

2. On the Clear BT Module Map dialog box, confirm that you want to 
clear the existing mappings, and click Yes.
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Link Module Configuration with RSLogix 5000 
Project

Introduction Now that the configuration, mode selection, and network preparation in the 
configuration tool are complete, the next steps include downloading the 
configuration to the 1756-RIO module and exporting aliases to the RSLogix 
5000 project. This completes the preparation of the 1756-RIO module for 
operation on a Remote I/O network.

In this chapter, you will:

• create aliases and export them to the RSLogix 5000 project.

• convert an older system to a ControlLogix system.

• download configurations to the module.

• upload configurations to the project.

• save configurations to disk.

• archive configuration templates.

Commission Summary The following list summarizes the steps to save and export your configurations 
from the configuration tool to the module, and import them to the RSLogix 
5000 project, so that you can begin scanning on a Remote I/O network.

1. Export aliases in scanner and adapter mode.

2. Download configurations to the 1756-RIO module.

3. Upload configurations to the RSLogix 5000 project.

4. Save configurations to disk.

5. Archive configurations.

Topic Page

Commission Summary 83
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Manage Configurations 91
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Aliases Aliases are used to access data in the ControlLogix system. They define the 
names and descriptions exported from the configuration program and 
imported into the RSLogix 5000 control program and should be used for 
adapter and scanner modes. 

Aliases are symbolic names that point to I/O data. The configuration tool 
creates these aliases for discrete and block transfer data based on the I/O 
mappings. It is important that you develop the control program in the 
RSLogix 5000 project with reference to aliases as opposed to absolute 
addresses. Then, if the mappings change, the ControlLogix controller still 
operates; you just create aliases for the new mappings by exporting them from 
the configuration tool and re-importing them into the control program, which 
then points to the new data.

Also, it’s important to note that export options in the configuration tool differ 
depending on whether you have your 1756-RIO module set for scanner or 
adapter mode.

In this section, you will cover:

• exporting aliases in scanner mode.

• exporting aliases in adapter mode.

• using the Export Aliases command in the configuration tool to upgrade 
an existing system to a ControlLogix system.

EXAMPLE For example, let’s say you’re mapped rack 7 inputs to block 0, 
offset 8, so the data for rack 7, I/O group 0, is at input address 
I0:[10]. Now you add a rack 6 and remap everything so that now 
the rack 7 input data maps to block 0, offset 20. 

The data for rack 0, I/O group 0, now moves to I0:[22]. 

If you had used absolute addresses in your control program, you 
would have to re-address every instruction in the program. By 
using aliases, you can use the Export Aliases command from 
the configuration tool and import them into the RSLogix 5000 
project, which automatically points to the new data.

IMPORTANT You must export the new aliases from the configuration tool 
and import them into the RSLogix 5000 project before you run 
the program; otherwise, you could read wrong inputs and/or 
write wrong outputs.
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Export Aliases in Scanner Mode
To export aliases in scanner mode, follow these steps.

1. On the Tools menu, choose Export Alias File.

2. On the Export RSLogix 5000 Aliases dialog box, enter the FileName, 
location, Alias Prefix, and Base Tag.

3. Click OK.

See Scanner Mode I/O Map on page 129 in Appendix C for more 
information.

Field Description

FileName Use the browse button to change the file location. 

Alias Prefix Use to distinguish between aliases for different 1756-RIO modules. If you have multiple 1756-RIO modules in the 
RSLogix 5000 project, assign each module a unique Alias Prefix so that the tags for each one are unique.

Base Tag Use the base tag to identify the 1756-RIO module location on the ControlLogix chassis.

This example shows the 1756-RIO module location 
in slot 0 of the local chassis.

Browse Button
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Export Aliases in Adapter Mode

To export aliases in adapter mode, follow these steps.

1. On the Tools menu, choose Export Alias File. 

2. On the Export RSLogix 5000 Aliases dialog box, enter the FileName, 
location, Alias Prefix, Base Tag, and RIO Output Placeholders.

3. Click OK.
For more information on the use of placeholders, see Use Monitor Mode to 
Upgrade an Existing System to a ControlLogix System on page 87.

Browse 
Button

Field Description

FileName Use the browse button ‘…’ to change the file location. 

Alias Prefix Use to distinguish between aliases for different 1756-RIO modules and to help identify groups of data items. If 
you have multiple 1756-RIO modules in the RSLogix 5000 project, assign each module a unique Alias Prefix so 
that the tags for each one are unique.

Base Tag Use the base tag to identify the 1756-RIO module location in the ControlLogix chassis.

RIO Output Placeholders Use this set of aliases when the 1756-RIO module is set to Monitor mode. These output placeholders aliases 
point to a ControlLogix internal array. If you are using Monitor mode, you can write your new application to 
write to this placeholder array and compare the monitored outputs to the outputs written by the new control 
program. If you don’t want the aliases, leave the box unchecked.

RIO Output Placeholders 
Base Tag

This tag must be created by the user in the ControlLogix control program and must be an integer array of 10 
RioTempOut elements (0…9), each with 255 sub-elements (0…254). So, RioTempOut would be 
RioTempOut[0,0] to RioTempOut[9,254].

Include BTW 
Configuration Words

Check this box if you choose to include aliases for block transfer write configuration data.
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Use Monitor Mode to Upgrade an Existing System to a 
ControlLogix System

To upgrade an existing system, such as a PLC-5, PLC-3, or SLC system, to a 
ControlLogix system, you have to perform these steps.

1. Monitor the network in adapter mode.

2. Write the new control program in RSLogix 5000 programming software 
to write to the internal array.

3. Compare the existing system’s outputs with the ControlLogix outputs, 
using the same live inputs.

4. Once both systems write the same outputs and have the same timing, 
switch over to the RSLogix 5000 control program for control.

Now it’s writing the real outputs instead of the placeholder array, using 
the 1756-RIO module to scan the network. 

You could use the same 1756-RIO module to monitor and scan the network. 
You would have to download the scanner firmware after you compare the 
systems using the module in adapter mode to monitor the network. Or, you 
could use two 1756-RIO modules; one as a scanner, and one as an adapter on 
the Remote I/O network.

The following example breaks down the process. It explains using the 1756-
RIO module:

• as an adapter and its configuration in the configuration tool’s I/O tree. 

• with the configuration tool to create the aliases based on the I/O 
configuration tree. 

• configuration tool’s process of exporting aliases to convert an existing 
system to a ControlLogix system using the module in scanner mode.

Create a Network Configuration and Export Aliases

Follow these steps to create a network configuration in the configuration tool 
and to create the aliases based on that configuration.

1. Set the 1756-RIO module to adapter mode. 

See Launch the Configuration Tool and Select the Module Mode on 
page 30.

2. Create the network configuration in the configuration tool’s tree for the 
1756-RIO module in adapter mode.
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The following I/O tree configuration comprises one monitored quarter 
rack and one active quarter rack.

3. Export the alias file. Once the network configuration is complete in the 
configuration tool, from the Tools menu, choose Export Alias File.

The following graphic and tables show how the configuration tool 
creates aliases based on the I/O configuration from the tree.

1

2

3

Item Description

1 Rack 00 is a monitored, quarter rack encompassing I/O groups 0 and 1

2 Rack 1 is an active quarter rack encompassing I/O groups 0 and 1

3 All input and output maps to connection 0, so, I0 and O0

ATTENTION Monitored outputs include outputs to monitored racks and 
outputs to active racks.

1
2
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The table shows how the prefixes are used in creating alias names, the 
descriptions that are created for the aliases, and how the addresses are 
created from the base tags and data mappings.

4. Write a ControlLogix control program in the RSLogix 5000 project to 
write outputs to the placeholder array, then compare the outputs to the 
monitored outputs from the existing system.

5. Change the 1756-RIO module to scanner mode; or use an existing 1756-
RIO scanner.

See Launch the Configuration Tool and Select the Module Mode on 
page 30.

6. Export a scanner configuration and download it to the scanner.

7. Create aliases with the scanner configuration tool using the same 
prefixes.

8. Import the aliases into the RSLogix 5000 project.

Item Description

1 Prefixes are left at their defaults.

2 The Base Tag field represents the location of the 1756-RIO adapter in the rack. In 
this case, the adapter is in slot 0.

Alias Name Description Address

RIO_R00_STS Rack-00 Status - Monitored Local:0:I0.Data[0]

RIO_I000 Rack-00 Grp-0 Discrete Input - Monitored Local:0:I0.Data[2]

RIO_I001 Rack-00 Grp-1 Discrete Input - Monitored Local:0:I0.Data[3]

RIO_MON_O000 Rack-00 Grp-0 Discrete Output - Monitored Local:0:I0.Data[12]

RIO_MON_O001 Rack-00 Grp-1 Discrete Output - Monitored Local:0:I0.Data[13]

RIO_MON_O010 Rack-01 Grp-0 Discrete Output - Monitored Local:0:I0.Data[22]

RIO_MON_O011 Rack-01 Grp-1 Discrete Output - Monitored Local:0:I0.Data[23]

RIO_ACT_I010 Rack-01 Grp-0 Discrete Input - Active Local:0:O0.Data[2]

RIO_ACT_I011 Rack-01 Grp-1 Discrete Input - Active Local:0:O0.Data[3]

RIO_O000 Rack-00 Grp-0 Discrete Output - Place Holder RioTempOut[0, 12]

RIO_O001 Rack-00 Grp-1 Discrete Output - Place Holder RioTempOut[0, 13]

RIO_O010 Rack-01 Grp-0 Discrete Output - Place Holder RioTempOut[0, 22]

RIO_O011 Rack-01 Grp-1 Discrete Output - Place Holder RioTempOut[0, 23]
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The following table shows the aliases created for a scanner in slot 0 in the 
ControlLogix chassis.

Notice that the alias names for the discrete outputs in the Export Alias 
Creation table are the same as the alias names for the placeholders in the Alias 
Creation for a Scanner in the ControlLogix Chassis table, but now point to I/
O outputs. 

Alias Creation for a Scanner in the ControlLogix Chassis

Alias Created Description Address

RIO_R00_STS Rack-00 Status Local:0:I0.Data[0]

RIO_R00_CTL Rack-00 Control Local:0:O0:Data[0]

RIO_I000 Rack-00 Grp-0 Discrete Input Local:0:I0.Data[2]

RIO_O000 Rack-00 Grp-0 Discrete Output Local:0:O0.Data[2]

RIO_I001 Rack-00 Grp-1 Discrete Input Local:0:I0.Data[3]

RIO_O001 Rack-00 Grp-1 Discrete Output Local:0:O0.Data[3]

EXAMPLE For example, an application that used alias name RIO_0001 
wrote to placeholder location RioTempOut[0, 13], but would 
now write to the discrete outputs at Local:0:O0:Data[3].
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Manage Configurations There are several ways to manage your module’s configurations. This section 
covers:

• downloading configurations to the module.

• uploading configurations to the RSLogix 5000 project.

• saving and loading configurations to disk.

• archiving configurations.

Managing configuration steps are the same for scanner and adapter modes.

Download and Upload Configurations

To download a configuration to the 1756-RIO module, follow these steps.

1. On the Configure menu, choose Download Configuration.

You must set the communication path through RSLinx to tell the 
configuration tool where the 1756-RIO module is installed. The RSLinx 
Path Selection dialog box now appears.

2. Expand the backplane of the chassis where the 1756-RIO module is 
installed, navigate to the module, and select it.

3. Click OK. 
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To upload a configuration from the 1756-RIO module to the project, follow 
these steps.

1. From the Configure menu, choose Upload Configuration.

2. Set the communication path when the RSLinx dialog box appears by 
navigating to the 1756-RIO module on the network, and clicking OK.

TIP You can also set the communication path by selecting the 
Communication menu and choosing Select RSLinx Path. 

TIP You can also upload/download configurations from the Module 
button on the configuration tool’s toolbar.

Download to the 
module.

Upload from 
the module.
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Save Configurations to Disk

To save configurations to disk, from the file menu, choose Save.

The configuration saves as an .rio file to the location you initially specified 
when you set the module properties in the add-on profile in the RSLogix 5000 
project.
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Archive Configurations

Archive Template Command

The Archive Templates command copies any templates used in the current file 
to the same location as the RIO file. It copies any block transfer module 
templates used in the current configuration file into the directory where the 
configuration is stored.

1. To archive configurations, from the File menu, choose Archive 
Templates.

2. When the confirmation dialog box appears, click OK.
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 Archive Template Check Command

The Archive Template Check command checks and confirms any block 
transfer module templates used in the current configuration file are stored in 
the directory where the configuration is stored.

1. To use the Archive Template Check command, from the File menu, 
choose Archive Template Check.

2. When the confirmation dialog box appears, click OK.

You must make sure you save your project if you want to keep a backup copy, 
otherwise, you get an error that the active project has not been saved, or the 
BT Template File is not found.

See Appendix C for additional information on templates.
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Notes:
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Monitor Remote I/O

Introduction Now that the module configuration is complete and downloaded to the 1756-
RIO module, you are ready to scan a Remote I/O network.

Remote I/O scanning uses a 1756-RIO scanner in a local or remote chassis 
and multiple adapters on a Remote I/O network. The scanner enables 
communication between a ControlLogix controller and the remote I/O 
devices. The 1756-RIO scanner continually gathers and sends information to 
and from remote adapters on the Remote I/O network and sends that 
information to the ControlLogix controller in the chassis.

Remote I/O monitoring uses a 1756-RIO module in adapter mode to ‘listen’ 
to remote I/O and communicate that I/O back to the ControlLogix 
controller.

Within the configuration tool there are four utilities to monitor I/O:

• DiscMon monitors discrete input and output data

• BtMon monitors block transfers

• DiagMon monitors diagnostic counters

• LogMon monitors the scanner log 

In this chapter, you will:

• use scan and monitor modes.

• monitor remote I/O discrete inputs and outputs in scanner mode.

• monitor remote I/O discrete inputs and outputs in adapter mode.

• monitor block transfers.

• export scanner configurations.

• use the diagnostic utilities in the configuration software to monitor, 
save, and clear diagnostics.
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Commission Summary The following list summarizes 1756-RIO scanning and monitoring functions 
on a Remote I/O network:

• Monitor discrete inputs and outputs in scanner mode from the Monitor 
menu.

• Monitor discrete inputs and active inputs in adapter mode from the 
Monitor menu.

• Monitor remote I/O in Monitor mode to ‘listen’ to, and then upgrade, 
an existing older system to a ControlLogix system.

• Monitor block transfer reads and writes in scanner mode by right-
clicking on the module in the I/O tree and selecting Monitor BT 
Module from the pull-down menu. 

• Export scanner configuration files in adapter mode using the Tools 
menu and clicking Export Scanner Configuration file File from the pull-
down menu.

• Monitor an existing system by putting the module in scanner mode and 
loading an exported configuration file to scan the remote network.

• Use the Monitor menu to monitor diagnostics in scanner and adapter 
modes. 

• Monitor normal operation and error messages on the network by using 
the Monitor menu’s Debug Log.

• Diagnose and correct fatal errors by selecting 1756-RIO Fatal Error 
from the Tools menu. Capture fatal errors and save them in an error log 
for use by Technical Support.
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Scan Mode and Monitor 
Mode

The 1756-RIO module can perform various scan functions depending on 
whether it is a scanner or an adapter.

Scan Remote I/O in Scanner Mode

There are three scan modes of the  ControlLogix controller. The following list 
explains each mode and what the 1756-RIO module does in each mode:

• Run mode

• Program mode

• Test mode

In run mode, the 1756-RIO module scans remote racks, reads discrete inputs, 
does not enable outputs to run on, and does not update block transfers.

In program mode, the 1756-RIO module scans remote racks, reads discrete 
inputs, but does not write discrete outputs, or update block transfers.

In test mode, the 1756-RIO behaves the same as it does in program mode, 
with the exception of the controller actively scanning the ladder logic.
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Monitor Remote I/O in Adapter Mode

The 1756-RIO module provides utilities to upgrade an existing remote I/O 
application to a ControlLogix system with a minimum of downtime and 
startup time. This function is referred to as Monitor mode. 

Used in Monitor mode, the 1756-RIO adapter can be used to upgrade a PLC-
5, PLC-3, or SLC system to a ControlLogix system by providing discrete 
inputs and outputs, and Block Transfer read and write data, to the controller. 
You can replace the existing application, or control program, that’s running on 
a PLC-5, PLC-3, or SLC system with a new application that runs on a 
ControlLogix controller using the 1756-RIO module as the remote I/O 
scanner.

TIP The replacement system must be tested before the switchover. 
It uses the same field wiring as the old system. If unanticipated 
problems arise, you can switch back to the old system in 
minutes.
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To use Monitor mode to upgrade your existing system to a ControlLogix 
system, follow these steps.

1. Connect the 1756-RIO module in adapter/Monitor mode on the 
existing Remote I/O network to monitor data and timing.

2. Create the new application, or control program, in the RSLogix 5000 
project. It sees the exact same inputs (monitored inputs) as the existing 
application, but writes to an internal array in the ControlLogix 
controller.

3. Compare the outputs (monitored outputs) from the new application 
with the outputs from the existing system by ‘listening’ to the network.

4. When you are satisfied that the new system accurately duplicates the 
function and timing of the existing system, disconnect the Remote I/O 
network from the old scanner and connect it to the 1756-RIO module 
in scanner mode. 

5. Switch the RSLogix 5000 project application (control program) to write 
outputs to the 1756-RIO module as a scanner, instead of to the internal 
array.

Monitor Discrete Inputs 
and Outputs

Use the Monitor Inputs and Monitor Outputs commands to display the 
discrete I/O data on remote I/O racks connected to the 1756-RIO module. 

If the RSLinx path to the 1756-RIO module has not been set, an RSLinx 
RSWho window displays. Use it to set the communication path to the module 
by navigating to the 1756-RIO module on the network, and clicking OK.

Monitor Discrete Inputs in Scanner Mode
To monitor discrete inputs in scanner mode, follow these steps.

1. From the Monitor menu, select Monitor Discrete Inputs.

2. Right-click on a rack and select Monitor Discrete.

3. Use the Monitor Discrete Inputs button on the toolbar.

ATTENTION Be sure to switch the 1756-RIO module to scanner mode, if it is 
not done.



Chapter 5        Monitor Remote I/O
The DiscMon, or discrete input monitor, window displays.

Each row corresponds to a rack. Rack numbers are given in octal. Each row 
shows eight words of discrete inputs for the rack number.

Main Menu Rack

Toolbar

ATTENTION You must set the RSLinx communication path for the module to 
start the DiscMon utility.
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Data can be displayed in the following formats.

Hexadecimal

You can display discrete I/O data in hexadecimal (0000…FFFF) format from 
the View menu, and choosing Hex, or by clicking the Display Hex button on 
the toolbar.

Signed Decimal

You can display discrete I/O data in signed decimal (-32768…32767) format 
by choosing the View menu, and choosing Signed from the pull-down menu, 
or by clicking the Signed button on the toolbar. 

Format From menu From Toolbar

Hexadecimal View/Hex 0x button

Signed decimal View/Unsigned 1 button

Unsigned decimal View/Signed -1 button

Main Menu Toolbar

Main Menu Toolbar
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Unsigned Decimal

You can display discrete I/O data in Unsigned Decimal (0…65535) format 
from the View menu, and choosing Unsigned, or by clicking the Unsigned 
button on the toolbar.

Monitor Discrete Outputs in Scanner Mode

To monitor discrete outputs in scanner mode, follow these steps.

1. On the main menu of the configuration tool, from the Monitor pull-
down menu, select Monitor Discrete Outputs.

2. Right-click on a rack and select Monitor Discrete Outputs.

3. Use the Monitor Discrete Outputs button on the toolbar.

Main Menu Toolbar

Main Menu Rack

Toolbar
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The Discrete Output Monitor window displays.

Each row corresponds to a rack. Rack numbers are given in octal and each row 
shows eight words of discrete outputs for the rack number.

TIP The data formatting options, hex, signed, and unsigned, are the 
same for scanner and adapter modes’ monitored inputs and 
outputs.
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Monitor Discrete Inputs in Adapter Mode

Monitored inputs are inputs on monitored racks. To monitor discrete inputs in 
adapter mode, from the Monitor menu, choose Discrete Monitored Inputs. 
Just as in scanner mode, you can also get to the Monitored Discrete Input 
Data screen by right-clicking on a rack, or clicking the Monitor Discrete Inputs 
button on the toolbar.
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The Monitored Discrete Input Data window displays.

Monitor Discrete Outputs in Adapter Mode

Monitored outputs are all outputs from the remote I/O scanner. To monitor 
discrete outputs in adapter mode, from the Monitor menu, select Discrete 
Monitored Outputs, or right-click on a rack, or click the Monitor Discrete 
Outputs button on the toolbar.

The Monitored Discrete Output Data window displays.
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Monitor Discrete Active Inputs in Adapter Mode

Active inputs are inputs on active racks. To monitor discrete active inputs in 
adapter mode, from the Monitor menu, choose Discrete Active Inputs, or 
right-click on a rack, or click the Monitor Active Inputs button on the toolbar.

The Active Discrete Input Data window displays.

Monitor Block Transfers Use the Block Transfer Monitor command to display the block transfers 
associated with a block transfer module, along with diagnostics associated with 
the block transfers.
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Monitor Block Transfers in Scanner Mode

To monitor a block transfer module, right-click on the module in the I/O tree 
and select Monitor BT Module from the pull-down menu.

The 1756-RIO BTMon, or block transfer module window, displays.

Some analog output modules have only an associated block transfer write. 
Analog input modules have a block transfer write for configuring the module, 
a block transfer read for data, and a block transfer read for status.

The upper portion of the screen is the block transfer read; the lower portion is 
the block transfer write.

The raw data can be displayed as hexadecimal, signed, or unsigned integer. The 
default format for block transfer data is hexadecimal.

ATTENTION You must set the RSLinx communication path to start the 
BTMon utility.

Block Transfer Read

Block Transfer Write
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Block Transfer Read Diagnostics

The following table lists the diagnostics for block transfer reads.

Scanner Mode Block Transfer Read Diagnostics

Counter Description

State Config/active/inactive.

Type Module type from the module template.

BTR Len Block transfer read length.

Req Update Time Requested update time in the module configuration, in ms.

Avg Update Time Average update time for this block transfer read, in ms. This is the average of the previous eight updates.

Min Update Time Minimum update time for this block transfer read, in ms.

Max Update Time Maximum update time for this block transfer read, in ms.

Update Count Running count of updates for this block transfer read.

Ignored Reqs Running count of update requests ignored by the block transfer module.

Prot Errors Running count of protocol errors for this block transfer read. If this counter is incrementing, the module isn’t 
responding correctly.

Request Count Count of the number of times on successive scans this block transfer was requested. If this number is 
consistently greater than 1, increase the requested update time - the module cannot respond quickly enough at 
the current requested time. The counter applies to the BTR and BTW for this module.
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Block Transfer Write Diagnostics

The following table lists the diagnostics for block transfer writes.

Scanner Mode Block Transfer Write Diagnostics

Counter Description

Cfg Len Length of the configuration data for this module.

Data Len Data length.

Req Update Time Requested update time in the module configuration, in ms.

Avg Update Time Average update time for this block transfer write, in ms. This is the average of the previous eight updates.

Min Update Time Minimum update time for this block transfer write, in ms.

Max Update Time Maximum update time for this block transfer write, in ms.

Update Count Running count of updates for this block transfer write.

Ignored Reqs Running count of update requests ignored by the destination module for this block transfer write.

Protocol Errs Running count of protocol errors for this block transfer write.
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Monitor Block Transfers in Adapter Mode

To monitor a block transfer module, right-click on the module in the I/O tree 
and select Monitor BT Module from the pull-down menu.

The BTMon, or block transfer module window displays.

ATTENTION You must set the RSLinx communication path to start the 
BTMon utility.

Block Transfer Read

Block Transfer Write
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Block Transfer Read Diagnostics

The following table lists the diagnostics for block transfer reads.

Adapter Mode Block Transfer Read Diagnostics

Counter Description

Type Module type

BTR Map Len Length of mapped BTR data, in words

BTR Mon Len Length of monitored BTR data, in words

Avg Update Time Average update time for this block transfer read, in ms

Min Update Time Minimum update time for this block transfer read, in ms

Max Update Time Maximum update time for this block transfer read, in ms

Update Count Running count of updates for this block transfer read
Publication 1756-UM534B-EN-P - November 2010 113



Chapter 5        Monitor Remote I/O
Block Transfer Write Diagnostics

The following table lists the diagnostics for block transfer writes.

Adapter Mode Block Transfer Write Diagnostics

Counter Description

BTW Map Len The length of the mapped BTW data, in words

BTW Min Len The minimum BTW length, in words

BTW Max Len The maximum BTW length, in words

Avg Update Time Average update time for this block transfer write, in ms

Min Update Time Minimum update time for this block transfer write, in ms

Max Update Time Maximum update time for this block transfer write, in ms

Update Count Running count of updates for this block transfer write
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Export Scanner 
Configurations

In adapter mode, the configuration tool can export a scanner configuration file 
built from the current adapter configuration, which can be loaded into an RIO 
scanner. The exported scanner configuration file is especially useful when 
converting an existing remote I/O system to a ControlLogix system. You can 
then choose whether the block transfer configuration data and update times 
come from the values the adapter has observed on the remote network, or 
from the defaults from the module templates.

The configuration file includes:

• a baud rate.

• monitored racks.

• block transfers on monitored racks.

It does not contain active racks, block transfers on active racks, or mappings.

To export a scanner configuration file follow these steps.

1. From the Tools menu, choose Export Scanner Configuration File.

2. On the Export Scanner Configuration File dialog box, select the 
FileName and BT Module Configuration Data and Update Times 
option for your configuration file. 

Make sure you use another file name so that you don’t overwrite the 
adapter configuration file.

EXAMPLE The template for a module might have a default value for the 
channel data type. The configuration seen on the network might 
have another value for the channel data type. 
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3. Click OK.

Monitor Mode

If you are using the 1756-RIO module in Monitor mode, you can monitor the 
existing system to capture block transfer timing and configuration data, then 
export a scanner configuration file that contains that data. To use the exported 
configuration file, follow these steps.

1. Switch the 1756-RIO module back to scanner mode.

2. Load the exported configuration file to scan the Remote I/O network.

Field Description

FileName Name the file and select the autobrowse button to search for the directory and/or file 
where you want to save the file.

The current *.rio file is for adapter mode. When you export the scanner configuration 
file, you are making a new *.rio file for scanner mode. You do not want to overwrite 
the adapter *.rio file, so it must be saved at this point.

BT Module Configuration Data and Update Times 

Capture from Online Monitor or Use Defaults from 
Templates

The configuration and timing data for block transfers can be based on the default 
configuration data from the block transfer module templates, or on the configuration 
data and update times the adapter has observed on the network.

This is a global selection and affects the data saved for all block transfer modules.
116 Publication 1756-UM534B-EN-P - November 2010



Monitor Remote I/O        Chapter 5
Other Diagnostics Use the Monitor Diagnostics Counters command to display the diagnostic 
counters that the 1756-RIO module maintains. The 1756-RIO module 
maintains diagnostic counters that indicate the state of communication on an 
entire Remote I/O network, and counters related to each rack. It also 
maintains an active rack list.

The diagnostic counters consist of three groups:

• Active racks table

• Global diagnostic counters

• Rack diagnostic counters

Monitor Diagnostic Counters in Scanner Mode

To monitor the diagnostic counters, follow these steps.

From the Monitor menu, choose Diagnostic Counters, or click the Monitor 
Diagnostic Counters button on the toolbar.

Main Menu Toolbar

ATTENTION You must set the RSLinx communication path for the module to 
start the DiagMon utility.
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The 1756-RIO DiagMon window displays showing the Active Racks, 
Global Diag Counters, and Rack Diag Counters.

Active Racks Table

The Active Racks table shows which racks are present on the Remote I/O 
network. Columns represent rack numbers from 1…76 octal. Rows represent 
starting I/O groups. If the bit for a rack and starting I/O group is set, there is 
a rack at that location. The Active Racks table does not show rack size.

A ‘1’ indicates that a rack is present at the rack number and starting I/O group 
indicated. In the example above, there is a rack present at rack 0, starting I/O 
group 0.

The ‘1’ in the Active Rack table 
indicates a rack present at rack 0, 
starting I/O group 0.
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Global Diagnostic Counters

The global diagnostic counters provide information about the operation of the 
entire Remote I/O network.

The following table lists the global diagnostic counters’ descriptions.

Scanner Mode Global Diagnostic Counters 

Counter Description

Tx This counter increments each time the 1756-RIO module transmits a packet.

RxGood This counter increments when the 1756-RIO module receives a good packet.

RxTout This counter increments when the 1756-RIO module sends a packet but does not receive a reply.

RxBadCRC This counter increments when the 1756-RIO module receives a packet with a bad Cyclic Redundancy Check (CRC). Check 
cabling and termination on the Remote I/O network.

RxNoise This counter increments when the 1756-RIO module hears a carrier without receiving a packet. Check cabling and 
termination on the Remote I/O network.

RxAbort This counter increments when the 1756-RIO module receives an opening flag, then the packet ends without a closing 
flag.

PrtclErr This counter increments when the 1756-RIO module receives a packet that makes no sense in terms of the protocol.

UpdAvg Average update time for all configured racks. This is the average of the previous 64 updates.

UpdMin Minimum update time for all configured racks.

UpdMax Maximum update time for all configured racks.
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Rack Diagnostic Counters

The rack diagnostic counters contain information about the operation of each 
partial rack. The rows are racks, from 1…76 octal. There are four groups of 
counters per rack, corresponding to the four possible starting I/O groups for 
a rack. 

The following table lists the rack diagnostic counters’ descriptions.

Monitor Diagnostic Counters in Adapter Mode

Follow this procedure to monitor diagnostic counters in adapter mode.

From the Monitor menu, choose Diagnostic Counters.

The 1756-RIO-ADPT DiagMon window displays. Notice that the Rack Status 
Table and the Global Diag Counters are the same in adapter mode as scanner 
mode diagnostics. The BT Global Update; however, shows the diagnostics for 
the BTRs and BTWs in adapter mode.

Scanner Mode Rack Diagnostic Counters

Counter Description

Rx This counter increments when the 1756-RIO module receives a packet from this rack.

Crc This counter increments when the 1756-RIO module receives a packet with a bad CRC from this rack.

Tout This counter increments when the 1756-RIO module sends a packet to this rack and does not receive a reply within the 
time-out period.

Prtcl This counter increments when the 1756-RIO module receives a packet from this rack that does not make sense in terms 
of the protocol.
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The BT Global Update diagnostics table is organized by rack, I/O group 
(Grp), and slot (Slt). The first row (0:) shows the BTRs first, then the BTWs 
on rack 0. From left to right, BTRs at I/O group 0, slot 0; I/O group 0, slot 1; 
I/O group 1, slot 0; I/O group 1, slot 1; and so on.

A lower case ‘r’ or ‘w’ indicates that a block transfer has been observed at that 
location at some point in the past. An upper case ‘R’ or ‘W’ indicates when a 
block transfer happens.

Module Scanner Log

Scanner Mode

The scanner log displays messages from the firmware running on the 1756-
RIO module, showing its normal operation and error messages. The Debug 
Log command monitors messages logged by the 1756-RIO module. These 
messages can be used to diagnose problems and may be useful in tracking 
down errors and for Technical Support.

Grp 0, Slt 0
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To monitor the scanner log, follow this procedure.

1. Run the LogMon utility. To launch LogMon, from the Monitor menu, 
choose Debug Log from the pull-down menu. 

 

2. Select OK once you select the 1756-RIO module on the network. 

A window displays confirming LogMon has started. If there are no 
errors present, the LogMon screen stays clear.

ATTENTION You must set the RSLinx communication path for the module to 
start the LogMon utility.
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The log displays module operations, version, and mode information. 
Something like below is typical, but your log will look different.

3. To clear the scanner log, from the Edit menu, choose ClearLog, or click 
the Clear Log button from the toolbar. 

4. To copy the contents of the log to the Windows clipboard for use in 
another application, from the Edit menu, choose Copy, or click the 
Select All and Copy button on the toolbar.

Main Menu Toolbar

Main Menu Toolbar
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Adapter Mode

To launch LogMon in adapter mode, follow these steps. 

1. From the Monitor menu, choose Debug Log.

 

2. Set the RSLinx communication path when prompted and Select OK to 
start LogMon.

Clear Diagnostics

To clear diagnostics, follow these steps. 

1. From the Monitor menu, choose Diagnostic Counters.

Once you set the communication path via RSLinx software, the 
DiagMon window displays. 

2. From the Actions menu, choose Clear Diagnostics, or click the Clear 
Diagnostics button on the toolbar.

TIP These same instructions apply for scanner and adapter mode.
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3. To clear Block Transfer diagnostics, while in BTMon, from the Actions 
menu, choose ClearDiagCounters, or click the ClearDiagCounters 
button on the toolbar.

Fatal Errors

Fatal errors occur when the firmware on the module encounters an 
unexpected condition. There are three main causes for fatal errors:

• A bug in the 1756-RIO module firmware

• A 1756-RIO module hardware failure

• Certain types of ControlLogix backplane failures 

The 1756-RIO module monitors its own operation for invalid conditions. The 
module stops scanning, turns all three status indicators red and displays a fatal 
error number similar to ‘M#60’ on the 4-character display, and then stores a 
fatal error log that indicates the cause of the fatal error.

ToolbarMain Menu

Main Menu Toolbar
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Use the Fatal Error Capture command from the Tools menu to clear fatal 
errors on the 1756-RIO module and save the log file to disk for use by 
technical support.

To clear the fatal error and capture the fatal error log for scanner and adapter 
modes, follow these steps.

1. Cycle power on the 1756-RIO module. 

The 4-character display should show ‘FatalErrorCapture required’.

2. From the Tools menu, choose 1756-RIO Fatal Error Capture.

3. Use RSLinx software to set the communication path and select the 
1756-RIO module on the network.

A Fatal Error Capture warning window displays.

4. Select Yes.

5. Save the fatal error log to a file. 

IMPORTANT Clearing a fatal error also clears the configuration on the 1756-
RIO module.

IMPORTANT By choosing Yes, communication to the module is disrupted, 
AND the module’s configuration will be erased.
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This also clears the fatal error on the module. When the Save In dialog 
box opens, navigate to the location on the hard drive where you want to 
save the error log file and give it a filename. 

6. Contact Technical Support. See the  BackCover.

7. Provide Technical Support with the fatal error log file to help them 
diagnose the cause of the problem.

8. After clearing the fatal error, you must download the configuration to 
the 1756-RIO module.

See Download and Upload Configurations on page 91 for instructions on how 
to download configurations to the 1756-RIO module.

ATTENTION You must clear the fatal error before you can use the module 
again, and you shouldn’t use it again until you have determined 
what caused the error.
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Notes:  
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Scanner Mode I/O Map

This section describes how the data gets mapped to the ControlLogix data for 
scanner mode. 

When you map any part of a rack to produced/consumed tag data, the 
structure that gets mapped is for the entire rack number. For example, if rack 1 
consists of I/O groups 0 and 1 (a quarter rack), the entire structure for rack 1 
is mapped when you map the rack. Similarly, if a rack is made up of several 
partial racks, mapping any one of those partial racks maps the structure for the 
entire rack.

Discrete Input Data

In scanner mode, the discrete read structure for a rack consists of two status 
words and eight words of discrete input data.

 Discrete Read Structure-Input

Only bits 0…3 of the first word of status data are used. They consist of error 
bits that are set if there is a communication error with a partial rack. Bit 0 
corresponds to a rack that starts at I/O group 0; bit 1 corresponds to a rack 
that starts at I/O group 2, and so on.

The error bit is 1 if there is an error scanning the rack, or if the rack is 
inhibited; otherwise, the bit is 0.

Words 2…9 contain the discrete input data for the rack. Words 2 and 3 
contain the data for I/O groups 0 and 1 (first 1/4 rack), words 3 and 4 contain 
the data for I/O groups 2 and 3 (second 1/4 rack), and so on.

0          1         2          3          4          5          6          7         8          9

Status Codes and  
Error Codes Discrete Input Data

1st 
16-bit 
Word

44817
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Discrete Input Data Offset - Read

Discrete Input Data Offset - Read

Offset 0
Status Word

0          1         2          3          4          5          6          7         8          9        10       11       12       13       14        15
Offset 2…9
Input Words

8 Words of Discrete Input Data

Offset 1
Status Word

0          1         2          3          4          5          6          7         8          9        10       11       12       13       14        15

Reserved (Pad for 32-bit Alignment)

Reserved 
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Discrete Output Data

In scanner mode, the discrete write structure for a rack consists of two control 
words and eight words of discrete output data.

Discrete Write Structure-Output

Bits 0…3 of the first word of control data are used to inhibit racks. Set bit 0 to 
inhibit the scan of the rack starting at I/O group 0; set bit 1 to inhibit the scan 
of the rack starting at I/O group 2; and so on. Inhibiting a rack stops all 
communication with that rack and all outputs revert to their programmed last 
state.

Bits 4…7 of the first word of control data are used to reset racks. Set bit 4 to 
reset the outputs of the rack starting at I/O group 0; set bit 5 to reset the 
outputs of the rack starting at I/O group 2; and so on. When a reset command 
is given, all communication with that rack continues; however, that rack 
behaves as if the controller is in Program mode. All outputs revert to their 
Program mode state.

Only the bit for the starting I/O group needs to be set to inhibit or reset the 
rack. For example, if a rack is a full rack starting at I/O group 0, only bit 0 
needs to be set to inhibit the scan of the rack.

Words 2…9 contain the discrete output data for the rack. Words 2 and 3 
contain the data for I/O groups 0 and 1 (first 1/4 rack), words 3 and 4 contain 
the data for I/O groups 2 and 3 (second 1/4 rack), and so on.

0          1         2          3          4          5          6          7         8          9

2 Control Words Discrete Output Data

1st 
16-bit 
Word

44818
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Discrete Output Data Table

Offset (Words) Bit Description

0 (Control) 0 Inhibit rack that starts first quarter (I/O group 0…1)

1 Inhibit rack that starts second quarter (I/O group 2…3)

2 Inhibit rack that starts third quarter (I/O group 4…5

3 Inhibit rack that starts fourth quarter (I/O group 6…7)

4 Reset rack that starts at first quarter (I/O group 0…1)

5 Reset rack that starts at second quarter (I/O group 2…3)

6 Reset rack that starts at third quarter (I/O group 4…5)

7 Reset rack that starts at fourth quarter (I/O group 6…7)

8…15 Reserved

1 (Control) 0…15 Reserved (pad for 32-bit alignment)

2…9 (Output) 0…15 Discrete output data

Discrete Output Data Offset - Write

Write
Offset 0 

Control Word

0          1         2          3          4          5          6          7         8          9        10       11       12       13       14        15
Offset 2…9

Ouput Words

8 Words of Discrete Ouptut Data

Offset 1
Control Word

0          1         2          3          4          5          6          7         8          9        10       11       12       13       14        15

Reserved (Pad for 32-bit Alignment)

Reserved 
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 Discrete I/O Data Transfer

Discrete Read Structure - Input

0          1         2          3          4          5          6          7         8          9

Status Codes and  
Error Codes Discrete Input Data

1st 
16-bit 
Word

I

O

I I I I I I I

O O O O O O O

0          1         2         3          4        5          6         7
Group Group Group Group

1/4
Partial Rack

1/4
Partial Rack

1/4
Partial Rack

1/4
Partial Rack

Read

Status Word
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I/O Rack

Scanner Mode
Discrete I/O Data Transfer
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Appendix A        Scanner Mode I/O Map
Block Transfer Input
In scanner mode, even if a module has only a block transfer write, you should 
map the module to input and output data, so that the control and status data 
gets mapped.

Block Transfer Read Structure-Input 

Offset 0 bits 0…7 contain a free-running counter that increments each time a 
block transfer read executes successfully on the RIO network. Based on 
configuration of the 1756-RIO module and its RPI, it may be possible that the 
controller may see this value increment by more than 1 count per program 
scan.

The 1756-RIO module sets the BTR error bit, offset 0 bit 11, when an error 
occurs executing a block transfer read. It clears the bit when the block transfer 
read enable bit is reset in the corresponding BT control write structure.

When a block transfer read error occurs, offset 0 bits 8…10 contain Error 
Codes.

When you execute a block transfer read in manual mode, the 1756-RIO 
module sets offset 0 bit 12 to indicate that the block transfer read executed 
successfully. The bit is reset when the corresponding BTR.EN bit is reset in 
the BT write control file.

Offset 1 bits 0…7 contain a free-running counter that increments each time a 
block transfer write executes successfully on the RIO network. Based on the 
configuration of the 1756-RIO module and its RPI, it may be possible that the 
controller may see this value increment by more than 1 count per program 
scan.

The 1756-RIO module sets the BTW error bit, offset 1 bit 11, when an error 
occurs executing a block transfer write. It clears the bit when the block transfer 
write enable bit is reset in the corresponding BT control write structure.

When a block transfer write occurs, offset 1 bits 8…10 contain an error code. 
When you execute a block transfer write in manual mode, the 1756-RIO 
module sets offset 1 bit 12 BTW.DN to indicate that the block transfer write 
executed successfully. The bit is reset when the corresponding BTW.EN bit is 
reset in the BT write control file.

Word offsets 2…n contain the read data returned by the block transfer 
module.

0          1         2          3          4          5          6          7         8          9

BTR Returned Read Data

1st 
16-bit 
Word

BTW

44821
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Scanner Mode I/O Map        Appendix A
Block Transfer Control Read Structure

BT Read Structure Table

Offset (Words) Bit Description

0 (BT Read) 0…7 BTR update counter (increments each time BTR executes, 0…255)

8…10 BTR error code

11 BTR.ERR, block transfer read error 

12 BTR.DN, block transfer read done (manual mode only)

13…15 Reserved

1 0…7 BTW update counter (increments each time BTW executes, 0…255)

8…10 BTW error code

11 BTW.ERR, block transfer write error

12 BTW.DN, block transfer write done (manual mode only)

13…15 Reserved

2…n 0…15 BTR data (64 integers, max)

BT Read
Offset Word 0

0          1         2          3          4          5          6          7         8          9        10       11       12       13       14        15
Returned Read Data 
Offset Words 2…n

Read Data Returned by the Block Transfer

BT Write
Offset  Word 1

0          1         2          3          4          5          6          7         8          9        10       11       12       13       14        15

Reserved 

0          1         2          3          4          5          6          7         8          9        10       11       12       13       14        15
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Appendix A        Scanner Mode I/O Map
Block Transfer Output

BT Write Structure-Output

Offset 0 bits 0…5 contain the block transfer read length.

Offset 0 bit 8 contains the block transfer read enable bit for manual mode 
block transfers.

Offset 0 bit 9 is used in two ways:

• In manual mode, this bit is the block-transfer-read-continuous bit. If 
this bit is set and the enable bit is set, the 1756-RIO module re-enables 
block transfer reads when they execute successfully.

• In automatic and semi-automatic modes, this bit inhibits all block 
transfers to the I/O module.

Offset 1 bits 0…5 contain the block transfer write length.

Offset 1 bit 8 contains the block transfer write enable bit for manual mode 
block transfers.

Offset 1 bit 9 is the block-transfer-write-continuous bit. If this bit is set and 
the enable bit is set, the 1756-RIO module re-enables block transfer writes 
when they execute successfully.

Word offsets 2…n contain the write data sent to the block transfer write 
module.

0          1         2          3          4          5          6          7         8          9

BTR Write Data Container for BTW Module

1st 
16-bit 
Word

BTW
44822
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Block Transfer Control Write Structure

BT Write Structure Table

Offset (Words) Bit Description

0 0…5 BTR length (1…63 word, 0 means BT module decides)

6…7 Reserved

8 BTR.EN, block transfer read enable (manual mode only)

9 BTR.CONT (manual mode only)

BT Inhibit (automatic modes - inhibits config BTW, data BTW and data BTR)

10…15 Reserved

1 0…5 BTW length (1…63 word, 0 means BT module decides)

6…7 Reserved

8 BTW.EN, block transfer write enable (manual mode only)

9 BTW.CONT, continuous mode (manual mode only)

10…15 Reserved

2…n 0…15 BTW Data (64 integers, max)

BT Read
Offset Word 0

0          1         2          3          4          5          6          7         8          9        10       11       12       13       14        15

Write Data Container
for BTW Module

Offset Words 2…n

Write Data Container

BT Write 
Offset Word 1 0          1         2          3          4          5          6          7         8          9        10       11       12       13       14        15

Reserved 

0          1         2          3          4          5          6          7         8          9        10       11       12       13       14        15
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Error Codes

Error Code Description

0 OK

1 BTR/BTW request ignored by block transfer module

2 Block transfer state mismatch

3…6 Reserved, not currently used

7 Disabled
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Scanner Mode Block Transfer I/O 

BT Read Structure - Input

0          1         2          3          4          5          6          7         8          9

BTR Returned Read Data

1st 
16-bit 
Word

BTW

Block Transfer Control Read Structure

BT Read

0          1         2          3          4          5          6          7         8          9        10       11       12       13       14        15
Returned Read Data
Offset 2…n 

Read Data Returned by the Block Transfer

BT Write 0          1         2          3          4          5          6          7         8          9        10       11       12       13       14        15

Reserved 
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Block Transfer Control Write Structure
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Appendix B

Adapter Mode I/O Map

This section describes the remote I/O data that gets mapped to the 
ControlLogix data for adapter mode.

The structures that get mapped for adapter mode are similar to those for 
scanner mode, with the exception of the control bits. In adapter mode, you 
have no control over when racks or block transfers update.

The I/O data can be remote I/O input or output data on monitored or active 
racks.

Discrete Data Discrete Input Data

In adapter mode, the discrete input structure for a rack consists of two status 
words followed by eight words of discrete input data. When you map any part 
of a rack to produced/consumed tag data, the structure that gets mapped is for 
the entire rack number.

Discrete Input Monitored Racks

Inputs on monitored racks are mapped to ControlLogix inputs.

Only bits 0…3 of the first word of status data are used. They consist of error 
bits that are set if there is a communication error with a partial rack. Bit 0 
corresponds to a rack that starts at I/O group 0; bit 1 corresponds to a rack 
that starts at I/O group 2, and so on.

The bit is set if there is an error scanning the rack and is 0 otherwise.

0          1         2          3          4          5          6          7         8          9

8 Words of Discrete Input Data

Only 
First 3 

Bits Used

1st 
Status 
Word

2nd 
Status 
Word

Not 
Used
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Discrete Input Data Monitored Racks

Discrete Input Data Monitored Racks

Offset (Words) Bit Description

0 (Status) 0 Communication error first quarter (I/O group 0…1)

1 Communication error second quarter (I/O group 2…3)

2 Communication error third quarter (I/O group 4…5)

3 Communication error fourth quarter (I/O group 6…7)

4…15 Reserved

1 0…15 Reserved (pad for 32-bit alignment)

2…9 0…15 Discrete input data

Offset 0
Status Word

0          1         2          3          4          5          6          7         8          9        10       11       12       13       14        15
Offset 2-9

Input Words

8 Words of Discrete Input Data

Offset 1
Status Word 0          1         2          3          4          5          6          7         8          9        10       11       12       13       14        15

Reserved (Pad for 32-bit Alignment)

Reserved 
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Discrete Input Active Racks

There are no status bits on active racks. Inputs on active racks are mapped to 
ControlLogix outputs.

Discrete Input Data Offset Active Racks - Read

0          1         2          3          4          5          6          7         8          9

8 Words of Discrete Input DataReserved Words

Not 
Used

Not 
Used

44850

Discrete Input Data Active Racks 

Offset (Words) Bit Description

0 0…15 Reserved

1 0…15 Reserved

2…9 0…15 Discrete input data

Offset 0
Reserved Word

0          1         2          3          4          5          6          7         8          9        10       11       12       13       14        15
Offset 2-9

Input Words

8 Words of Discrete Input Data

Offset 1
Reserved Word 0          1         2          3          4          5          6          7         8          9        10       11       12       13       14        15

Reserved (Pad for 32-bit Alignment)

0          1         2          3          4          5          6          7         8          9        10       11       12       13       14        15

Reserved (Pad for 32-bit Alignment)
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Appendix B        Adapter Mode I/O Map
Discrete Output Data on Monitored or Active Racks

In adapter mode, the discrete output structure for a rack consists of two pad 
words and eight words of discrete output data. Whenever you map a rack to 
ControlLogix inputs, 10 words of data get mapped for remote I/O inputs and 
10 words get mapped for remote I/O outputs.

Discrete outputs on monitored and active racks are mapped to ControlLogix 
inputs.

0          1         2          3          4          5          6          7         8          9

8 Words of Discrete Output Data

Reserved Words
Not Used

44852
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Discrete Output Data on Monitored or Active Racks

Offset 0
Reserved Word

0          1         2          3          4          5          6          7         8          9        10       11       12       13       14        15
Offset 2- 9

Output Words

8 Words of Discrete Output Data

Offset 1
Reserved Word

0          1         2          3          4          5          6          7         8          9        10       11       12       13       14        15

Reserved 

Reserved 

0          1         2          3          4          5          6          7         8          9        10       11       12       13       14        15

44853

Discrete Output Data on Monitored or Active Racks

Offset Bit Description

0 0…15 Reserved

1 0…15 Reserved

2…9 0…15 Discrete output data
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Adapter Mode Discrete I/O Data Transfer-Monitored Racks

Discrete Read Structure - Input

0          1         2          3          4          5          6          7         8          9

8 Words of Discrete Input Data
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Status Words

ControlLogix Input Tags

Read
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0 = Status OK 1=Error

Reserved

0          1         2          3          4          5          6          7         8          9        10       11       12       13       14        15Output Words

8 Words of Discrete Output (Monitored Racks)

Reserved
0          1         2          3          4          5          6          7         8          9        10       11       12       13       14        15

Reserved 

Reserved 

0          1         2          3          4          5          6          7         8          9        10       11       12       13       14        15
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1/4
Partial Rack

1/4
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1/4
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I/O Rack

0          1         2          3          4          5          6          7         8          9

8 Words of Discrete Output Data

1st 
16-bit 
Word

Discrete  Output (Monitored Racks) 

ControlLogix Input Tags
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Adapter Mode Discrete I/O Data Transfer-Active Racks

I/O Rack

p

Offset 0
Reserved Word

0          1         2          3          4          5          6          7         8          9        10       11       12       13       14        15
Offset 2-9

Input Words

8 Words of Discrete Input Data

Offset 1
Reserved Word 0          1         2          3          4          5          6          7         8          9        10       11       12       13       14        15

Reserved (Pad for 32-bit Alignment)

0          1         2          3          4          5          6          7         8          9        10       11       12       13       14        15

Reserved (Pad for 32-bit Alignment)

Discrete Read Structure - Input Monitored Racks

0          1         2          3          4          5          6          7         8          9

8 Words of Discrete Input DataReserved Words

Not 
Used

Not 
Used

Discrete Output
Active Racks Only

Offset 0
Reserved Word

0          1         2          3          4          5          6          7         8          9        10       11       12       13       14        15
Offset 2- 9

Output Words

8 Words of Discrete Output Data

Offset 1
Reserved Word

0          1         2          3          4          5          6          7         8          9        10       11       12       13       14        15

Reserved 

Reserved 

0          1         2          3          4          5          6          7         8          9        10       11       12       13       14        15

0          1         2          3          4          5          6          7         8          9

8 Words of Discrete Output Data

Discrete Write Structure Monitored Racks - Output

Reserved Words
Not Used

I

O

I I I I I I I

O O O O O O O

0          1         2         3          4        5          6         7
Group Group Group Group

1/4
Partial Rack

1/4
Partial Rack

1/4
Partial Rack

1/4
Partial Rack

ControlLogix Output Tags

ControlLogix Input Tags
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Appendix B        Adapter Mode I/O Map
 Block Transfer Modules This section shows the structures that get mapped to ControlLogix produced/
consumed input or output data when you map a block transfer module. 

Even if a module has only block transfer read or write data, you should map 
the module to produced/consumed input and output data, so that the control 
and status data gets mapped.

On monitored racks, block transfer read and write data maps to ControlLogix 
inputs.

On active racks, block transfer read data maps to ControlLogix output data. 
Block transfer write data maps to ControlLogix input data.

Block Transfer Read Data on Monitored or Active Racks

Block transfer read data on monitored racks are mapped to ControlLogix 
inputs.

Block transfer read data on active racks are mapped from ControlLogix 
outputs.

Block Transfer Reads on Monitored or Active Racks

Offset Description

0 Reserved, always 0

1 Reserved, always 0

2…n Up to 64 words of BTR data

0          1         2          3          4          5          6          7         8          9...

Reserved Block Transfer Read Data Up To 64 Words 

1st 
16-bit 
Word

44855
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Block Transfer Read Structure

Block Transfer Control Read Structure

Offset Bit Description

0 0…15 Reserved

1 0…15 Reserved

2…n 0…15 BTR data (64 integers, max)

 Offset 0
Reserved Word

0          1         2          3          4          5          6          7         8          9        10       11       12       13       14        15Offset 2-n
BTR Data

BTR Data (64 integers, max)

Offset 1
Reserved Word 0          1         2          3          4          5          6          7         8          9        10       11       12       13       14        15

Reserved 

0          1         2          3          4          5          6          7         8          9        10       11       12       13       14        15

Reserved 

44846

On monitored racks, this is mapped to ControlLogix inputs. 
On active racks, this is mapped to ControlLogix outputs.
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Block Transfer Write Data on Monitored or Active Racks

The data mapped for block transfer writes consists of two status words 
followed by up to 64 words of data on active or monitored racks. Block 
transfer write data on active and monitored racks are mapped to ControlLogix 
inputs.

Offset 0 bits 0…7 contain a free-running counter that increments each time a 
block transfer read executes successfully.

The 1756-RIO module sets the BTR error bit; offset 0, bit 11, when an error 
occurs executing a block transfer read. It clears the bit when the block transfer 
read enable bit occurs.

When a block transfer read error occurs, offset 0, bit 8…10 contain an error 
code.

The error codes are as follows.

 

Block Transfer Error Codes

Error Code Description

0 OK

1 Time-out

0          1         2          3          4          5          6          7         8          9...

BTR Block Transfer Write Data

1st 
16-bit 
Word

BTW

44843

44847
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Block Transfer Write Structure

Block Transfer Write Structure on Monitored or Active Racks

Offset Bit Description

0 0…7 BTR update counter (increments each time BTR executes, 0…255)

8…10 BTR error code

11 BTR.ERR, block transfer read error

12…15 Reserved

1 0…7 BTW update counter (increments each time BTW executes, 0…255)

8…10 BTW error code

11 BTW.ERR, block transfer write error

12…15 Reserved

2…n 0…15 BTW data (64 integers, max)

Offset Word 0
BT Read

0          1         2          3          4          5          6          7         8          9        10       11       12       13       14        15

 
Offset Words 2-n

BTW Data

BTW Data (64 integers, max)

Offset  Word 1
BT Write

0          1         2          3          4          5          6          7         8          9        10       11       12       13       14        15

0          1         2          3          4          5          6          7         8          9        10       11       12       13       14        15

BTR Error BTR Update Counter Bl
oc

k 
Tr

an
sf

er
 

Re
ad

 E
rr

or

BTW Update Counter BTW Error Bl
oc

k 
Tr

an
sf

er
 

W
rit

e 
Er

ro
r

Reserved 

Reserved 

44844

Block transfer writes on active and monitored racks are 
mapped to ControlLogix inputs.
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Adapter Mode Block Transfer I/O

Offset Word 0
BT Read

0          1         2          3          4          5          6          7         8          9        10       11       12       13       14        15

 
Offset Words 2-n

BTW Data

BTW Data (64 integers, max)

Offset  Word 1
BT Write

0          1         2          3          4          5          6          7         8          9        10       11       12       13       14        15

0          1         2          3          4          5          6          7         8          9        10       11       12       13       14        15

BTR Error BTR Update Counter Bl
oc

k 
Tr

an
sf

er
 

Re
ad

 E
rr

or

BTW Update Counter BTW Error Bl
oc

k 
Tr

an
sf

er
 

W
rit

e 
Er

ro
r

Reserved 

Reserved 

I/O Rack

BT Read Structure - Input

0          1         2          3          4          5          6          7         8          9...

BTR Block Transfer Write Data

1st 
16-bit 
Word

BTW

BT Write Structure - Output

0          1         2          3          4          5          6          7         8          9...

Reserved Block Transfer Read Data Up To 64 Words 

1st 
16-bit 
Word

I

O

I I I I I I I

O O O O O O O

0          1         2         3          4        5          6         7
Group Group Group Group

1/4
Partial Rack

1/4
Partial Rack

1/4
Partial Rack

1/4
Partial Rack

 Offset 0
Reserved Word

0          1         2          3          4          5          6          7         8          9        10       11       12       13       14        15Offset 2-n
BTR Data

BTR Data (64 integers, max)

Offset 1
Reserved Word 0          1         2          3          4          5          6          7         8          9        10       11       12       13       14        15

Reserved 

0          1         2          3          4          5          6          7         8          9        10       11       12       13       14        15

Reserved 

Mapped as ControlLogix input data for active and monitored racks.

Mapped as ControlLogix input data for monitored racks.
Mapped as ControlLogix output data for active racks.
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Block Transfer Module Templates

Block transfer module templates have been created and installed by the add-on 
profile for these modules.

Supported Modules

Not all modules are listed. If your module is not in the list, you can use the 
Generic BT_MODULE profile in the software, or create your own template 
specific to your exact module or configuration. This appendix covers the 
basics for creating your own module template.

The properties of block transfer modules are defined in files in the 
subdirectory ’Templates’ of the directory where the 1756-RIO software is 
installed. Template files have the extension BtModTpl. The BtModTpl files 
can be opened with Microsoft Notepad.

Template files are simple text files that define the properties of the block 
transfer module.

I/O Family Cat. No.

1746 SLC · 1746-N14

· 1746-N18

· 1746-N04V

· 1746-NT4

1771 PLC-5 · 1771-DE · 1771-NIV

· 1771-IFE-16CH (in single-ended 16 
Channel configuration)

· 1771-NOC-noBTR

· 1771-IFE-8CH (in differential 8 
Channel configuration)

· 1771-NOC

· 1771-IL-Alarms · 1771-NOV-noBTR

· 1771-IL · 1771-NOV

· 1771-IR · 1771-NR

· 1771-IXE · 1771-OFE-diag

· 1771-NIV-Alarms · 1771-OFE

1794 FLEX · 1794-IE4XOE2 · 1794-OE4

· 1794-IE8

TIP The best way to create a template is to use an existing 
template as an example. Use one that is similar to what you 
want to create, copy it to a new file, and modify it. The 
following are examples of template records.
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Block Transfer Template Records

Description

A template usually contains a description record, which consists of the 
keyword Desc, followed by an equal sign and up to 79 characters of text 
enclosed in quotes.

The description text displays in the configuration dialog box for any modules 
created from the template.

Note

A note record, which consists of the keyword Note, followed by an equal sign 
and then up to 79 characters of text enclosed in quotes, conveys information 
that a user needs when creating a module from this template.

The note text displays in the configuration dialog box for any modules created 
from the template.

ATTENTION Anything after a semicolon on a line is treated as a comment 
and is ignored.

EXAMPLE Desc="1771-IFE - 8 Channel Single Ended"

Desc="1771-OFE - Binary Format, No BTR"

EXAMPLE Note="Always set mapped output data word 0…8880 
hexadecimal in the ControlLogix"
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Block Transfer Lengths

A block transfer has three lengths associated with it.

CfgLen

The configuration length, ’CfgLen’, is the length of the additional 
configuration block transfer write data sent once to the block transfer module 
to initialize it.

BtwLen

The block transfer write length, ’BtwLen’, is the length of the block transfer 
write sent to the module during normal data update.

BtrLen

The block transfer read length, ’BtrLen’, is the length of the block transfer read 
received from the module during normal data update. Default Configuration 
Data Values

The template usually contains default values for the configuration block 
transfer write.

CfgData

Each value consists of the keyword ’CfgData’, an offset enclosed in square 
brackets, an equal sign, and the data value.

Offset Value

The offset is an offset into the configuration block transfer write and ranges 
from 0…(BtwLen+CfgLen-1).

Data Value

The data value can be expressed in decimal or hexadecimal (leading 0x, as 
shown in the example above).

EXAMPLE CfgData[ 8]=0x0fff
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The configuration program uses the default configuration data to select the 
initial values when you create a block transfer module from the template.

Parameters

Parameters let you assign values to the configuration data different from the 
default values for a specific module created from a standard template.

Parameters appear in the configuration dialog for any modules created from 
the template.

Parameter definitions begin with the keyword ’ParmDesc’ and end with the 
keyword ’ParmEnd’.

Parameter definitions contain:

• a description to display in the module dialog.

• the location in the dialog box.

• the location in the configuration data.

• a data value.

Description

Parameter definitions begin with the keyword ’ParmDesc’, which is followed 
by an equal sign and then up to 39 characters of text, to be displayed in the 
dialog box.

Location in Dialog Box

The screen location in terms of row (Row=0-63) and column (Col=0-2) where 
the parameter displays in the dialog box.

Location in the Configuration Data

The location of the parameter in the configuration block transfer is defined in 
terms of offset, data mask, and bit shift.

The offset is the offset into the configuration block transfer, from 0…63. It is 
specified by the keyword ’Ofs’, an equal sign, and the offset value.

EXAMPLE CfgData[ 4]=0x8000  ; 0-3:DataPol, 4 6 8 10:MinScaPol, 5 7 9 
11:MaxScalPol, 15:BinFmt

CfgData[ 5]  ; Min Scale ch 1
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The shift is the number of bits. The value you enter is shifted left, from 0…15. 
It is specified by the keyword ’Shift’, an equal sign, and the shift value.

The mask selects bits in the value you enter. It is specified by the 
keyword’Mask’, an equal sign, and the mask value, usually in hexadecimal.

The value you enter is logically ANDed with the mask, shifted left by the shift 
value, and ORed into the configuration word given by the offset.

Data Value

Data values can be defined as a numerical value or from a selection list. 
Numerical values are defined in terms of a format (BcdSgn, BcdUns, BinSgn, 
or BinSgn), the corresponding data value, mask and shift values, and minimum 
and maximum values. Selection lists can contain up to 256 selection values. 
The configuration dialog for a module created from the template displays the 
names of the selection values.

EXAMPLE Ofs=8 Mask=0x00ff Shift=2
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Parameter Examples

Example 1: Numeric Value

; Min Scale

ParmDesc="Min Scale Ch 1 :" Col=0 Row=0 Ofs=5 Mask=Oxffff 
Shift=0

          BinSgn MinVal=-4095 MaxVal=4095

ParmEnd

Example 2: Selection

; Channel 1

ParmDesc="Range Select Ch 1:"Col=0 Row=2 Ofs=0 Mask=0x0003
Shift=0

          Select=" 1 to 5V, 4 to 20mA", 0

          Select=" 0 to 5V, 0 to 20mA", 1

          Select="-5 to 5V,-20 to 20mA", 2

          Select="-10 to 10V, 0 to 10V", 3

ParmEnd
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Aliases

Aliases define the names and descriptions exported from the configuration 
program and imported into the RSLogix 5000 project. They begin with 
keyword ’AliasInp’ or ’AliasOut’, an offset enclosed in square brackets, a name 
consisting of up to 15 characters enclosed in quotes, and a description 
consisting of up to 79 characters enclosed in quotes.

EXAMPLE AliasInp[ 0]="_DAC_Ch1" ,"Raw Data Channel 1"

AliasOut[ 0]="_Ch1"  ,"Data - Channel 1"
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Appendix D

Troubleshooting Display and Status 
Indicators

This section covers problems that may occur with your 1756-RIO module. 
The following areas are covered:

• 1756-RIO module’s alphanumeric display

• RIO status indicator

• CLX status indicator 

• OK status indicator

• Debug log

• Fatal errors

• Updating the firmware

Alphanumeric Display The 4-character, alphanumeric display shows ‘RIO Scanner’, or ‘RIO Adapter’, 
followed by the firmware version number, and any banner text defined in the 
module configuration.

The display shows the following messages at power-up.

If the indicator on the 1756-RIO module does not cycle through these 
messages on powerup, contact Technical Support.

Message Description

B#nn Stages in the start-up processes; nn is a hexadecimal number

Boot Next stage in power-up sequence

RIO Scanner v. x.xx.xx Module firmware revision
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Status Indicators The 1756-RIO module has three status indicators to indicate the state of 
internal operations. The status indicators are labeled RIO, CLX, and OK.

RIO Status Indicator – Remote Devices Status

The RIO indicator displays the status of the Remote I/O network connection. 
Status varies depending on the mode of the module.

Scanner Mode

In order of priority, highest first.

Module Display and Indicators

Indicator Description

1 Module status display

2 RIO status indicator

3 CLX status indicator

4 OK status indicator

Indicator Status Description

RIO Red A frame-receive error has been received in the last 
second (CRC error, abort, or time-out). Indicator stays 
red for 1 second after the error occurs.

One or more racks are in error.

Flashing red/
off

At least one rack being scanned (not inhibited) is in 
error. One or more racks are inhibited.

Yellow Idle, no racks are configured.

Flashing 
yellow/off

All configured racks are inhibited.

Flashing green/
off

No racks being scanned (not inhibited) are in error, but 
one or more racks are inhibited.

Green Successful communication with all configured racks, 
no inhibited racks.

RIO   CLX    OK

44777ADAPTER MOD 1

2 3 4
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Adapter Mode

In order of priority, highest first.

CLX Status Indicator – ControlBus Status

The CLX indicator displays the status of communication with the 
ControlLogix processor.

Indicator Status Description

RIO Red A frame-receive error has been received in the last second 
(CRC error, abort, or time-out). Indicator stays red for 1 
second after the error occurs.

Flashing red/
off

One or more racks are not being scanned.

Flashing green/
off

Configuration mismatch on one or more racks.

Green All racks are being scanned and there are no configuration 
mismatches.

Indicator Status Description

CLX Green The module has successfully processed a request from the 
ControlBus backplane within the last five seconds. All 
required connections are open.

Flashing green/
off

Controlling Connection is open, but not all required 
connections are open.

Yellow Idle, no requests received from the backplane in the last 
five seconds. No connections; empty configuration.

Flashing yellow/
off

Controlling Connection is not open.

Red The module has returned a CIP error to a request from the 
backplane within the last second. All required connections 
are open.

Flashing red/off The module has returned a CIP error within the last second. 
All required connections are not open.
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OK Status Indicator – Module Health 

The Debug Log
The firmware on the 1756-RIO module maintains a log of informational and 
diagnostic messages that can be useful in determining the cause of 
configuration and network problems.

To view the log, select Monitor>Debug Log, in the scanner or adapter 
configuration program within the configuration tool.

Fatal Errors
Fatal errors occur when the firmware on the module encounters an 
unexpected condition. The module stops running, turns all three status 
indicators red, and displays the fatal error number on the 4-character display. 
The module also records its state at the time the fatal error occurred in a log. 

To clear the fatal error and capture the fatal error log, follow these steps.

1. Cycle power on the module. The 4-character display should show 
“FaltalErrorCaputure required.”

2. From the Tools menu, choose 1756-RIO Fatal Error Capture in the 
scanner or adapter configuration program.

3. Store the fatal error log to a file. 

This also clears the fatal error on the module.

Contact Technical Support and provide them with the fatal error log file to 
help diagnose the cause of the problem.

Indicator Status Description

OK Green Indicates that module has passed all power-up diagnostics 
and is functioning normally.

Red Indicates that module startup diagnostics failed, or a major 
module fault such as watchdog time-out, or jabber inhibit 
occurred.

IMPORTANT If all three status indicators are solid red and the 4-character 
display shows M#xx, (where xx is the error number), a fatal 
error has occurred. See Fatal Errors . Make a note of the error 
code numbers to give Tech Support, if you must call for help.
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Watchdog and Jabber Inhibit

A watchdog timer is implemented in the module’s hardware. If the firmware 
does not kick the watchdog within the time-out period, the watchdog times 
out and generates a fatal error with error code D1. In scanner mode, the 
module stops scanning. In adapter mode, all racks stop communication.

A jabber inhibit timer is implemented in the module’s hardware. If the network 
transmitter is on longer than 150% of the longest network frame time, the 
jabber inhibit forces the transmitter off and generates a fatal error with error 
code D0. 

In scanner mode, the module stops scanning. In adapter mode, the module 
stops communicating on the back plane and Remote I/O network.

Updating the Firmware

The module firmware updates using the scanner or adapter configuration 
program. To update the firmware, in the configuration tool, from the Tools 
menu, choose Set 1756-RIO Scanner/Adapter Mode. Setting the mode loads 
the latest firmware onto the module.
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Quick Start

ControlLogix System Quick 
Start

Use the following steps to quickly get the module running in a ControlLogix 
system. Detailed information about each step is available in other sections of 
this manual or in the installation manual. You can have only one scanner per 
RIO network. Remove any other scanners on the RIO network before 
continuing. The RIO module ships in scanner mode. You can adjust the 
instructions to fit the mode that matches your needs. 

1. Install RSLinx software, version 2.54 or later, with an activation. Use 
RSLinx Gateway or RSLinx Professional software. Do not use RSLinx 
Lite software.

2. Install RSLogix 5000 programming software, version 17 or later, and the 
associated controller firmware.

3. Install the 1756-RIO module in the 1756-ControlLogix chassis. 

See publication 1756-IN610.

Install the 1756-RIO module’s add-on profile found on the installation 
CD shipped with the module, or download it from  
 http://support.rockwellautomation.com/controlflash/LogixProfiler.asp. 

RSLinx software and RSLogix 5000 programming software must be 
installed before the add-on profile.

See page 19. 

4. Create a project in RSLogix 5000 programming software. 

5. Add a 1756 controller to your project. 

See page 23.

6. Add a 1756-RIO module to the project by right-clicking on the chassis 
in the Controller Organizer and selecting New Module. 

The Select Module dialog box appears. 

7. Expand the Communications heading and select the 1756-RIO module. 
Click OK.

See page 24.

8. Select the General tab on the Module Properties dialog box to set the 
module properties. 

http://literature.rockwellautomation.com/idc/groups/literature/documents/um/1756-in610_-en-p.pdf
http://literature.rockwellautomation.com/idc/groups/literature/documents/in/1756-in610_-en-p.pdf
https://uregp.rockwellautomation.com/UnifiedRegUI/displayLogin.do?myAction=Verify&myFromPage=http://support.rockwellautomation.com/_mem_bin/redir.asp
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9. Enter the module name and slot number. 

See page 24.

10. Click the Change button in the Module Definition section. Select your 
desired mode, scanner or adapter. 

The module ships in scanner mode. Note the number of input/output 
tags. If this number is not the same after you map your data with the 
configuration tool, you will have to return to this screen and change 
them to match your configuration. You can specify independently the 
number of input and output tags within the range of 1…10. Each tag 
you create will create a block of 248 integers. For example, a value of 2 
will create 2x248, or 498 integers. 

11. When done, click OK on the Module Definition dialog box.

See page 25. 

12. Select the Connection tab on the Module Properties dialog box.

13. Set the Requested Packet Interval (RPI). 

See page 27.

14. Click on the Remote I/O tab, name the RIO file, and click the OK 
button. 

15. Choose Yes on the Create dialog box.

See page 31.

This will close the Module Properties dialog box. You will need to 
double-click on the 1756-RIO module in the controller organizer to re-
open the Module Properties dialog box. 

16. Click on the Configure Remote I/O Devices button on the Module 
Properties dialog box to launch the configuration tool.

17. In the configuration tool, if needed, under the Tools menu, select Set 
1756-RIO Module Scanner/Adapter Mode command to match the RIO 
module functionality to match your application, Scanner or Adapter.

See pages 33.

18. Configure the RIO module to match your application. In scanner mode, 
add the desired racks to scan, and any block transfer modules. In adapter 
mode, configure the desired racks to be emulated, or monitored, and 
add any block transfer modules. Map all entries, either manually, or by 
using the Automap command.

See pages 51 and 76.
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19. Download the configuration to the module. From the configuration 
tool’s Configure menu, choose Download Configuration. Set the 
communication path when prompted.

See page 91.

20. Save the project.

21. Go online in the RSLogix 5000 project and download the configuration 
to the controller.

See page 30.

See Chapters 2 and 3 for in-depth information on setting module modes and 
configuration. 
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Symbols
*.rio file 116

Numerics
1756-RIO module 12
4-character display 13, 125
56RioCfgAdpt 19, 69
56RioCfgScan 19, 33, 40, 57

A
absolute addresses 84
ActBTR 78
ActInp 77
active 67
active inputs 98, 108
active rack 46, 61, 67, 108

table 117
adapter 11

configuration 115
mode 11, 15, 62, 86, 87, 98, 124, 165
program 19

add-on profile 15, 16, 19, 167
alias prefix 85
aliases 56, 76, 84, 89
analog 46, 109

data 72
archive

configurations 94
template check command 95
templates command 94

asynchronous 29
auto 64

configuration 65
configure 41, 62
map 62
mapping 53

automatic 49
automatic block transfers 50
Avg Update Time 113, 114

B
backplane 66, 125
base tag 85
baud rate 39, 63, 115
block transfer 64, 72, 136

data 11, 37
input 134
module 11, 70, 72
module type 74

monitor command 108
read 98, 109
read data 78
read-and-write-update rates 50
timing 116
update 50, 66
write 78, 109

blue 68
blue hose 14
BT

global update 120
global update diagnostics table 121
MODULE 72
Module 98
-module 48
Module Parameterization 48
Mon 109
template file 95

Bt
Mon 97

BT-MODULE 66
BTR

Len 110
len 75
Length 73
Map Len 113
Mon Len 113

BTW
Length 73
Map Len 114
Max Len 114
Min Len 114

btw len 75

C
clear

all mappings 57, 80
block transfer module data mappings 82
diagnostics 124
Log 123
rack map 58

CLX 14
Clx Input 78
Clx Input data 77
Clx Output 78
Clx Output data 77

communication path 62, 91
configuration

tool 29, 54, 83
tree 67

configure 64
adapter mode 61-82
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scanner mode 37-59
connections 51
control program 87
controller organizer 16, 167
ControlLogix

controller 11
controller inputs 78
inputs 77, 141
outputs 77, 87

counter 134
Cyclic Redundancy Check 119

D
data

blocks 54
offset 54, 77

debug log 98, 121
delete

partial rack 46
rack 46, 71

DiagMon 97, 117, 120
diagnostic counters 120
diagnostics 111, 114
DiscMon 97, 102
discrete 37, 46

data 11
input data 129
inputs 99
output data 131
outputs 90, 99, 107
read structure 129
write structure 131

door label 13, 14
download 44, 65, 127
DTL32.DLL 20

E
electronic keying 26
empty configuration 64
emulate 15, 61, 67
ending I/O group 68, 70
error bit 129, 134
export 51, 56, 76

aliases 84, 86
scanner configuration 97, 115

F
fatal error log 125
fatal errors 98, 125

firmware 15, 121, 125, 165

G
generic module type 67
global diagnostic counters 117

H
hardware 125
hexadecimal 103, 109

I
I/O

data 76
discrete inputs 97
discrete outputs 98
module 50, 72

import 56
inhibit 131
input tags - output tags 26
inputs 37
integer 109
internal array 87, 101

J
jabber inhibit timer 165

L
ladder logic 99
LED Banner name 39, 63
lightning bolt 67, 68
link module configuration 83-95
listen 97, 101
LogMon 97, 122

M
main menu 117
manual 49

mode 50, 134, 136
manually map 53
map 62
mapping configuration 51
Max Update Time 113, 114
Min Update Time 113, 114
mode 31
module

definition 17, 168
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profiles setup dialog box 21
type 73

MonBTR 78
MonBTW 78
MonInp 77
monitor 112

BT module 109
diagnostics counters 117
discrete inputs 101
discrete outputs 104
inputs 106
mode 11, 15, 61, 100
outputs 101

monitored rack 46, 61, 67, 72, 115
MonOut 77
MPSetup.exe program 20

N
network

configuration 64
traffic 66
tree 43, 69

O
octal 102, 105, 118
offset 55, 134, 136
OK 14
output table 52, 57, 76, 79
outputs 15, 37

P
packet 119
partial rack 41, 67, 120, 129
PLC-5, PLC-3, or SLC 15
produced/consumed

data 11, 61, 67
data connections 79
input data 69
tag 11, 51, 129

program mode 50, 64, 99, 131
protocol 119, 120

Q
quarter rack 68, 129

R
rack

diagnostic counters 117, 120

map discretes 53
number 102
type 70

red 68
re-import 56
re-map all command 56
Remote

I/O network 117, 165
remote

chassis 97
I/O 67, 69
I/O inputs 61
I/O network 11, 37, 73, 97
I/O outputs 61
I/O scanner 73, 77, 100
I/O scanner inputs 77
network 16

requested pack interval 11, 22
resize 45, 69, 70
resize partial rack 70
RIO 14

output placeholders 86
output placeholders base tag 86

root 69
row 120
RPI 11
RSLinx

communication path 102, 109, 117, 124
Gateway 15
Professional 15
software 15, 16, 124, 167

RSLogix 5000
control program 84
programming software 15, 16, 87, 167
project 22, 24, 67, 76, 89, 101

RTB connection 13
run mode 50, 64, 65, 99

S
scanner 11

configuration file 115
log 121
mode 15, 37, 85, 99, 109, 122, 131

scanner mode I/O map 129-139
semi-automatic 49, 50
shadow 15
signed 109
signed decimal 103
slot 72, 121

number 25
starting I/O group 68, 118
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T
template 46, 72
termination 119
test mode 99
throughput 29
timing data 116
toolbar 92, 117, 124
tools menu 88
tree 72, 87

troubleshooting display and status 
indicators 161-165

U
unassigned I/O addresses 76
unsigned 109
unsigned decimal 103, 104
update block transfers 99
Update Count 113, 114
upgrade 101
upload 92
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Rockwell Automation Support

Rockwell Automation provides technical information on the Web to assist you in using its products. 
At http://www.rockwellautomation.com/support/, you can find technical manuals, a knowledge base of FAQs, technical and 
application notes, sample code and links to software service packs, and a MySupport feature that you can customize to make the
best use of these tools.

For an additional level of technical phone support for installation, configuration, and troubleshooting, we offer TechConnect 
support programs. For more information, contact your local distributor or Rockwell Automation representative, 
or visit  http://www.rockwellautomation.com/support/.

Installation Assistance

If you experience a problem within the first 24 hours of installation, review the information that is contained in this manual.
You can contact Customer Support for initial help in getting your product up and running.

New Product Satisfaction Return

Rockwell Automation tests all of its products to ensure that they are fully operational when shipped from the manufacturing facility. 
However, if your product is not functioning and needs to be returned, follow these procedures.

Documentation Feedback 

Your comments will help us serve your documentation needs better. If you have any suggestions on how to improve this document, 
complete this form, publication RA-DU002, available at http://www.rockwellautomation.com/literature/.

United States or Canada 1.440.646.3434

Outside United States or 
Canada

Use the Worldwide Locator at http://www.rockwellautomation.com/support/americas/phone_en.html, or contact 
your local Rockwell Automation representative.

United States Contact your distributor. You must provide a Customer Support case number (call the phone number above to obtain 
one) to your distributor to complete the return process.

Outside United States Please contact your local Rockwell Automation representative for the return procedure.

http://literature.rockwellautomation.com/idc/groups/literature/documents/du/ra-du002_-en-e.pdf
http://www.rockwellautomation.com/support/americas/phone_en.html
http://www.rockwellautomation.com/support/
http://www.rockwellautomation.com/support/
http://www.rockwellautomation.com/literature/
http://www.rockwellautomation.com/locations/
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